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This documentation contains proprietary information of Stratasys Ltd. This information is supplied solely to assist
authorized users of Stratasys Eden260V 3D printing systems. No part of this document may be used for other purposes.

The specifications on which this document is based are subject to change without notice.

Trademarks

Stratasys, Objet, Eden, Eden260V, Objet Studio, Job Manager, , FullCure, and PolyJet are trademarks of Stratasys Ltd.
and/or its subsidiaries or affiliates and may be registered in certain jurisdictions. All other product names and trademarks
are the property of their respective owners.

FCC Compliance

The equipment referred to in this guide has been tested and found to comply with the limits for a Class A device pursuant
to part 15 of the FCC rules. These limits provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. Stratasys 3D printing systems generate, use and can radiate radio-
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful
interference, in which case the user will be required to correct the interference at his own expense.

The 3D printer referred to in this guide contains a transmitter module, FCC ID YH6-RFID.

NOTE: Stratasys is not responsible for radio or TV interference caused by unauthorized modification to this equipment.
Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the
equipment.

Equipment Recycling

®

In the European Union, this symbolindicates that when the last user wishes to discard a product, it must be sent to
appropriate facilities for recovery and recycling. For information about proper disposal, check your purchase contract, or
contact the supplier of the equipment.

Limitation of Liability

The product, software or services are being provided on an “asis” and “as available” basis. Except as may be stated
specifically in your contract, Stratasys Ltd. expressly disclaims all warranties of any kind, whether express or implied,
including, but not limited to, any implied warranties of merchantability, fitness for a particular purpose and non-
infringement.

You understand and agree that Stratasys Ltd. shall not be liable for any direct, indirect, incidental, special, consequential
or exemplary damages, including but not limited to, damages for loss of profits, goodwill, use, data or other intangible
losses (even if Stratasys has been advised of the possibility of such damages), resulting from: (i) the use or the inability to
use the product or software; (ii) the cost of procurement of substitute goods and services resulting from any products,
goods, data, software, information or services purchased; (i) unauthorized access to or alteration of your products,
software or data; (iv) statements or conduct of any third party; (v) any other matter relating to the product, software, or
services.

The text and drawings herein are for illustration and reference only. The specifications on which they are based are
subject to change. Stratasys Ltd. may, at any time and without notice, make changes to this document. Stratasys Ltd., for
itself and on behalf of its subsidiaries, assumes no liability for technical or editorial errors or omissions made herein, and
shall not be liable for incidental, consequential, indirect, or special damages, including, without limitation, loss of use, loss
or alteration of data, delays, or lost profits or savings arising from the use of this document.
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Eden260V User Guide 1 About This Guide

Using This Guide

This user guide provides instructions for installing, operating and maintaining
Eden260V 3D printing systems. It explains how to use features, and provides
practical examples to guide you as you use the system.

Important: Read the entire Safety chapter before using the system.

The text and figures in this guide are based on the Eden260V 3D printer,
software version 27.5 and Objet Studio software version 9.2.

This guide assumes that—
» all the hardware, software, and network components of your system are
installed, configured, and operating correctly.

« the operator has a working knowledge of the Windows® PC platform.

For More Information

Visit the Stratasys Support Center to download the latest revision of this
document.This document is also available on the Support Center in other
languages.

If you have any questions or comments about the way information is presented in
this guide, or if you have any suggestions for future editions, please send a
message to c-support@stratasys.com.

Revision History

The following table lists the main changes in each revision of this document.

Revision

Release Date Description

Rev. F

February 2021  About this Guide was updated.
» Additional Resources was added.
* Replacing the Odor Filter was updated.

* Replacing the UV Lamps was updated with
instructions for replacing the UV lamp bulb.

* Photobleaching for Transparent Models was
updated.

+ Text, style and format improvements.

DOC-32020 Rev. F
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Terms Used in This Guide

Build tray

Cleaning fluid

Client/user
workstation

host/server
workstation

Job Manager

Model material

Objet Studio

OBJDF

OBJTF

OBJZF

Printer
computer

Printer
interface

Printer
software,
printer-control
application

DOC-32020 Rev. F

In the print preparation application: The surface displayed on the
screen that represents the actual build tray in the printer.
In the printer: The surface upon which models are produced.

Cleanser for flushing material feed tubes and the printing block, used to
completely remove Model and Support material from the system before
loading another type of material in the printer and before long-term
shutdown. The cleaning fluid is supplied in material cartridges.

The workstation on which software is installed for preparing build trays
for production on PolyJet printers. (There is no limit to the number of
client workstations.)

The workstation that interfaces directly with the Eden260V printer and
is typically positioned next to it.

The part of Objet Studio software that manages production jobs before
they are sent to the PolyJet printer.

Material used for building models.

A software application that prepares files for printing on Stratasys
PolyJet printers.

The extension of a file that contains information about the geometry of
an object and the materials required to print it. objdffiles are created in
Objet Studio.

The extension of a file that contains all of the information needed for a
model-printing job on PolyJet 3D printers. An objtffile is used by Objet
Studio to send a print job to a PolyJet 3D printer.

The extension of a compressed “wrapper” file containing all of the files
used in an Objet Studio build tray. Using objzffiles, a printing job can
be saved as a single file, for convenient storage and transfer.

The computer inside the Eden260V printer that operates it.

The GUI (graphical user interface) used for controlling Eden260V
printers.

Software running on the computer in the Eden260V printer, controling
all printer operations.

1-3
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Resin

SLC

STL

Support
material

DOC-32020 Rev. F

The base substance from which photopolymer printing materials are

made for use in Stratasys PolyJet printers.
In Objet Studio and printer-application screens, “resin” refers to cartridges of
model and support materials.

A file that contains bitmaps of individual slices of an object, for printing
3D models.

A file used for printing 3D models.

Material used for supporting the structure of models during production.

1-4



Eden260V User Guide 1 About This Guide

Additional Resources

Stratasys encourages you to learn more about your additive manufacturing
printer, its capabilities and the technology. A wealth of information is available on
our online digital platforms.

Stratasys Academy

DOC-32020 Rev. F

Stratasys Academy is your online learning platform. Here you can browse our
extensive and growing course catalog, register to webinars, view tutorials and
videos at your own pace, and enroll in face-to-face, in person courses. We
encourage you register and start your leaning journey today.

Stra Welcome User Demo
Bign Out
ACADEMY™ MHome Hﬁumﬁdhrm

e e T W

Stratasys Academy”

IR 1B soneyom ey Trae Find Learning

[ soeas

it i o w1 LEASN soakary™ & 4

Brewse all coarses >

COMTAUE COURSE | -,

Core Application Essentials - Design For Additive
Manufacturing Using PolyJet Technology
ELEARMNMNG 182057

A SetAigres

OFTIMAL CONTINLE COWRSE

Core Application Essentials - Manufacturing Aids
Jigs&Fixtures

E-LEARNMG 1000003
PTIONL CONTIMUE COURSE | -,

| Core Application Essentials - PolyJet Multi-
Matenals
E-LEARraRG 1000082

Introduction to 3D Printing
E-LEARMPd 1000051


https://stratasys.plateau.com/learning/user/portal.do?siteID=CUSTOMERS&landingPage=login
https://support.stratasys.com/Academy Registration
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Stratasys Support Center

The Support Center is your portal to thousands of knowledge assets, including
information on design, applications, and materials. The site also has links to
Web-based training, "how-to" videos and the Stratasys blog. In addition, you can
check the latest revision of the user guide for your printer, and download
documents in different languages.

The Support Center is available in multiple languages. You can change the
display language using the language drop-down menu in the top-left corner of
the homepage.

@ English ~ Stratasys.com | Request Support | Stratasys eStore | Stratasys Academy™ Contact Us

A
$ stratasys |

Printers Materials Applications Industries Resources Translated Resources 7.0

Welcome to

Type in keyword below and click the search icon

I -

GrabCAD Community

The Tutorials section of GrabCAD Community portal is a valuable source for
Stratasys-sponsored and user-genertated 3D printing tips. You can also ask 3D-
related questions on the portal and download free CAD files.

GRABCAD

Learn from thousands of free Tutorials

Join the Community

DOC-32020 Rev. F 1-6
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Safety Features

Stratasys 3D printers are designed to comply with CE and FCC
standards. They are equipped with the following safety features:

Interlock Switch

The power supplied to the UV lamp, the tray heater and the
motion motors is turned off when the cover is opened.

& Warning

Do not defeat (override) the interlock switch. Doing so could
result in serious personal injury. If the interlock switch does not
function correctly, do not use the printer, and contact your service
provider.

Safety Lock

The cover is locked while the printer is working. The lock is
released when the printer reverts to pause or stop mode.

Warning

Do not defeat (override) the safety lock. Doing so could result
in serious personal injury. If the safety lock does not function
correctly, do not use the printer, and contact your service provider.

UV Screening

The transparent section of the cover blocks harmful UV radiation,
allowing the operator to view models as they are being made.

UV screen

Cover interlock

Figure 2-1 Front view of the Eden260V printer

Circuit Breaker

The power to the printer is turned off in case of electrical
overcurrent.

Note: The circuit breaker is only accessible to service personnel.

DOC-32020 Rev. F 2-2
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UV-Lamp Overheating
Protection

Grounded Chassis

If the printer is not used as specified in this guide, these safety features may not provide

The power supplied to the UV lamp, the tray heater and the

motion motors is turned off if the temperature around the lamp

reaches 90°C (194°F). A label on the UV-lamp cover indicates if
the temperature has exceeded 65°C (150°F).

The chassis of the printer is grounded, to prevent electrical shock.

Note: The power outlet must be grounded in accordance with the
local electric code to provide this protection.

adequate protection.

Symbols and Warning Labels

The following table lists the warning labels located on or in the printer.

Warning Symbol

Meaning

Location

Comments

Hazard (general)

On the name plate on the

Read the instructions in

back of the printer. this document before
operating the printer.
Hot surface On the print block. Risk of burns. Do not
touch this surface after
printing.
High voltage Near the UV lamp Risk of electric shock.

connectors.

Near the power-supply
enclosures.

Disconnect the power
before servicing.

Ultraviolet radiation

Near the UV lamps.

Risk of injury to skin and
eyes from ultraviolet
radiation. Disconnect the
power before servicing.

DOC-32020 Rev. F
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Safety Guidelines

The following general guidelines, together with the instructions provided
throughout this user guide, ensure user safety while operating and maintaining
the system. If the system is not operated as specified, the user's safety
may be compromised.

Printer Installation

>

Printer Operation

DOC-32020 Rev. F

>

\l

Y Y VY VY

Installation and removal of the printer should only be done by qualified service
personnel.

Connect the printer (and the UPS unit) to the electric outlet using a power
cable that is safety-certified.

The electric outlet should be easily accessible, near the printer.

Never connect the power plug to an outlet that does not have a ground (earth)
wire, and never disconnect the ground. Doing so might expose the operator
to serious danger from electric shock.

The following safety statement is followed by translations to Finish,
Norwegian, Swedish and Danish, as required by local regulations:

“The machine must be connected to a grounded power outlet.”

O FI: Laite on liitettdva suojakoskettimilla varustettuun pistorasiaan.

3 NO: Apparatet ma tilkoples jordet stikkontakt.

O SE: Apparaten skall anslutas till jordat uttag.

O DK: Apparatets stikprop skal tilsluttes en stikkontakt med jord, som giver
forbindelse til stikproppens jord.

Leave a minimum of 15 centimeters (6 inches) between ventilation openings
and wallls or other objects.

For Japan: The power cable supplied is provided for connecting the printer
to the AC electric source. Do not use it with other equipment.

The printer should only be operated by persons trained by an authorized
Stratasys representative.

All persons operating or maintaining the printer should know the location of
first aid and emergency equipment and how to use it. Never block access
to this equipment.

Keep fingers and other body parts clear of the printer when closing the cover.
Never attempt to open the printer while it is working.

Never override the interlock safety switch.

If the interlock safety switch ever fails, do not use the printer.

Several parts of the printer remain extremely hot even after it has stopped
operating. Avoid touching the UV lamps and the print block.

2-4
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UV Radiation

The UV lamps used in the printer emit dangerous radiation

> Ifthe UV lamps remain on when the printer is open, do not stare directly at the
UV light. Shut down the printer and call your Stratasys service provider.

Printer Maintenance

> Service operations should be performed only by qualified personnel who
have been instructed in relevant safety precautions.

> Notify co-workers and those who have access to the printer before beginning
non-routine and hazardous work.

% Report any potential dangers and safety-related accidents to your safety

officer or to other appropriate authorities.

Model and Support Materials

DOC-32020 Rev. F

Model and Support materials are made of chemical substances. Although
precautions must be taken when handling these materials directly, all Model and
Support materials used by the printer are handled in sealed cartridges. Normally,
operators of the printer should never be directly exposed to hazardous materials.
In the unlikely event of a leak or spill, follow the instructions that are included with
the material cartridges used.

> Store Model and Support materials indoors, in a dry area with adequate
ventilation, between 15-25 degrees Celsius (59-77 degrees Fahrenheit).
Never expose them to flames, heat, sparks, or direct sunlight.

> Keep Model and Support materials away from areas where food and drink
are stored, prepared and consumed.

> Uncured printing material is considered a hazardous substance, requiring
certain precautions when directly handling it. To prevent skin irritation, wear
neoprene or nitrile gloves. If there is any chance that Model and Support
materials might splash into the eyes, wear safety goggles. Prolonged direct
contact with printing materials can cause an allergic reaction.

> When handling UV-cured models that may not be completely cured on the
surface, common latex gloves are adequate.

> To prevent respiratory irritation, ventilate areas where Model and Support
materials are used. If the printer is not equipped with an exhaust duct, the
room ventilation system should replace the air 4—6 times per hour.

> Clean up Model-material and Support-material spills with disposable towels
or other absorbent, non-reusable material, such as sawdust or activated
charcoal. Rinse the spill area with denatured or isopropyl alcohol (IPA),
followed by soap and water. Dispose of the absorbent material in accordance
with local regulations.

> Do not wash contaminated clothing at home; clothing should be
professionally laundered.

2-5
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> Dispose of contaminated shoes, belts and other leather items in accordance
with any applicable regulations. Absorbed printing material may re-expose
the user when these items are worn.

UV Lamps

UV lamps used by the printer to cure printing materials contain a small amount of
mercury. In the unlikely event of lamp breakage, avoid inhaling mercury vapor,
and ventilate the room. If the lamp ruptures (breaks) during operation, leave the
room and ventilate it thoroughly for about 30 minutes.

Use protective gloves to prevent contact with mercury and other lamp
components. Carefully remove spilled mercury with a method that prevents the
generation of mercury vapor, such as a syringe, packing tape or paper.

Place the broken lamp, mercury and contaminated materials in an air-tight, non-
metallic container. Dispose of the container in accordance with applicable
regulations.

DOC-32020 Rev. F 2-6
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First Aid for Working with Printing Materials

In general, try to avoid direct contact with uncured printing material. If skin or
eyes come into contact with it, wash the area immediately and thoroughly with
water, and follow these first-aid instructions.

The Material Safety Data Sheet (MSDS) that accompanies printing materials
contains important safety information. Keep this in an accessible place where
these materials are used and stored.

Contact with Skin

If uncured printing material comes in contact with skin, wash the affected area
immediately and thoroughly with soap and cool water, then remove
contaminated clothing. Pay particular attention to flushing the hair, ears, nose
and other parts of the body that are not easily cleaned.

> Use cool water to prevent skin pores from opening, so that the liquid material
does not easily penetrate the skin.

> Do not use solvents to clean skin.

> Iflarge areas of skin have been exposed, or if prolonged contact results in
blisters, seek medical attention. In any case, if irritation persists, seek medical
attention.

> Avoid the accidental transfer of printing material from the hands to other
areas of the body, especially to the eyes.

> If protective cream was used, do not reapply it until the skin has been
completely cleansed.

Contact with Eyes

Ingestion

DOC-32020 Rev. F

If uncured printing material comes in contact with the eyes, flush immediately
with large amounts of water for 15 minutes and seek medical attention.

> Avoid sunlight, fluorescent light, and other sources of ultraviolet radiation.

Wearing contact lenses when handling liquid printing materials is not
recommended. If the liquid splashes into the eyes when contact lenses are worn,
immediately remove the lenses and flush the eyes with water.

> Clean and disinfect the contaminated lenses.

> Do not wear contact lenses until eye irritation disappears.

If printing material is swallowed, refer to the instructions included with the
cartridge. Seek medical attention immediately.

2-7
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Inhalation

Vapors from printing materials can be irritating to the respiratory system. If
respiratory irritation occurs, expose the victim to fresh air immediately.

>

>
>
>
>

If the victim has stopped breathing, perform artificial respiration or
cardiopulmonary resuscitation.

Seek medical attention immediately.
Keep the victim warm but not hot.
Never feed anything to an unconscious person.

Oxygen should be administered by authorized personnel only.

Waste Disposal

Fully cured printed models can be disposed of as ordinary office trash. However,
special care is required when handling printer waste (uncured printing material).

Printing Materials

UV Lamps

DOC-32020 Rev. F

>

When removing the waste container from the printer, wear neoprene or nitrile
gloves.

To prevent liquid waste from splashing into the eyes, wear safety goggles.

Liquid waste from the printer is classified as hazardous industrial waste.
Therefore, printing-material waste must be packaged and disposed of in a
manner that prevents human contact with it and contamination of water
sources.

Empty Model-material and Support-material cartridges contain residue of
their contents. Some leakage of this residue may occur through the broken
cartridge seal. Therefore, handle and store empty cartridges with care.

Do not attempt to reuse empty cartridges, and do not puncture them.

Dispose of used cartridges and waste containers in accordance with local
regulations.

Discard contaminated clothing, shoes, empty containers, etc., in accordance
with any applicable regulations.

UV lamps used by the printer to cure printing materials contain a small amount of
mercury, and are considered “Universal Waste.” Recycle or discard used lamps
in accordance with applicable regulations.

Broken lamps:

After ventilating the area, use protective gloves and carefully remove spilled
mercury with a method that prevents the generation of mercury vapor, such as a
syringe, packing tape or paper. Place the broken lamp, mercury and
contaminated materials in an air-tight, non-metallic container. Dispose of the
container in accordance with applicable regulations.
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Work Configurations

Eden260V 3D printing systems can be set up as single-station systems or as
multi-station systems. When connected to a local computer network, the system
can serve multiple users. In such configurations, each user (client) prepares files
for production. A server, typically next to the printer, sends jobs to the printer.

Figure 3-1 shows the printer set up in a multi-client configuration.

Client
workstations
s as

Printer
__ KAV switch
Printer

‘ workstation

N ﬁ

Figure 3-1 Multi-client network configuration

When jobs are sent to the printer, Job Manager, on the server computer,
arranges them according to their priorities, model-material type, and other
factors. In multi-workstation configurations, the operator of the server—typically
the production administrator—has total control over the jobs sent to the printer,
and can prioritize jobs, delete jobs, review job history and reprint jobs.
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Source Files

STL Files

SLC Files

DOC-32020 Rev. F

Eden260V printing systems produce three-dimensional models designed with
most CAD tools and some other 3D applications.

Objet Studio supports these file formats:

£ STL

+ SLC
Eden260V systems feature the capability of producing different types of model
files simultaneously.

STL is short for STereoLithography or Standard Triangulation Language. This
language views any object as a collection of surfaces, and describes each
surface of the object as a collection of triangles.

For example, a square can be described as two triangles; a cube (six squares) as
12 triangles. Curved surfaces need more triangles to describe them. The higher
the tolerance (for smooth surfaces), the more triangles are needed.

Most CAD software can export STL files. Objet Studio/ opens these files for
printing models on the printer.

SLC is short for Stereo-Lithography Contour. SLC files describe two-
dimensional contours of the three-dimensional models. These contour lines are
polylines.

SLC files are ASCII (text) files that save models as a series of slices. This means
that models based on SLC files cannot be orientated; only their scale (size) and
position on the build tray can be controlled. For this reason, the model’s
orientation must be suitable for production before it is saved as an SLC file.
Because of the nature of SLC files, the appearance of models in Objet Studio
may be different than the solid-object images displayed from STL files.
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Printing Materials

Eden260V printers produce models by jetting thin layers of printing materials on
the build tray, until the complete model is formed. Two types of material are used
in this process:

* Model material—which makes up the finished model

» Support material—which fills gaps and spaces in the model during printing,
and is removed after printing

% For up-to-date information about PolyJet printing materials and their
properties, go to www.stratasys.com/materials/polyjet.

Storage

Materials used for printing models with Eden260V printers are made of resins,
which are composed of reactive monomers and oligomers. Although printing
materials are supplied in sealed, UV-proof cartridges, care must be taken when
storing and handling them. Follow these guidelines to protect operators and the
environment, and to ensure optimum results.

» To ensure product stability, do not allow these materials to come into contact
with metal. Plastics made from monomer-soluble substances (such as
polystyrene or polyvinyl chloride) are not suitable for storing PolyJet printing
materials.

* When not in use, keep material cartridges tightly sealed to prevent
contamination, the effects of exposure to UV radiation, and accidental
spillage.

» Store material cartridges indoors, in a dry area with adequate ventilation,
between 15-25 degrees Celsius (59-77 degrees Fahrenheit). If exposed to
heat or flames, cartridges might burst or ignite.

+ Signs of premature polymerization in material cartridges include bulging,
leaking, the emission of heat, and unusual odor. Exposure to heat can cause
resin to gel in the cartridges.

* Make sure that material cartridges are stored in accordance with all local
regulations and other applicable requirements.

Shelf Life
Materials used for producing models have a limited shelf life. The expiry date on

the label is valid when properly stored in an undamaged, unopened cartridge.
Always rotate your stock, so that the cartridge with the earliest date is used first.

Exposure to Light

If printing materials are not in their sealed cartridges, make sure to shield them
from sunlight and other sources of UV radiation, such as fluorescent and
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mercury-vapor lights. Exposure to UV radiation causes an increase in viscosity
and, eventually, solidification.

Safety Considerations

Before being cured, resins are hazardous materials. To prevent possible health
hazards, follow these precautions regarding printing materials:

» Do not expose to flames, heat or sparks.
*» Prevent contact with skin and eyes.

* Ventilate areas where they are handled.

» Keep them separate from food and drink.
Cured plastic parts, however, are safe. They can be handled and stored without
precautions.

% You can find more safety information about resins in:

« "Safety Guidelines" on page 2-4
« "First Aid for Working with Printing Materials" on page 2-7

Disposal

Dispose of cartridges of model and support material in accordance with all
applicable laws and regulations.

Work Environment

Extreme heat and humidity conditions can adversely affect the operation of your
Eden260V 3D printer. Use ventilation or air-conditioning systems, if necessary,
to keep the work area within the following ranges:

* 18°-25° C (64°-77° F)
* 30%—70% relative humidity

Workstation Requirements

Objet Studio Workstation

The requirements for client computers running Objet Studio are listed in the
Eden260V Site Preparation Guide. You can download this document from

stratasys.com.
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Preparing Files for Use with PolyJet 3D Printing Systems

Before printing design files with the Eden260V printer, make sure that they are in
a file format supported by the applications you are using to send print jobs to the
printer—Objet Studio. (See "Source Files" on page 3-3.)

Converting CAD Files to STL Format

This procedure may vary slightly, depending on the CAD software used, but the
following instructions generally apply.

To convert a file to STL format (in a CAD program):

1. From the File menu, select Save As.

2. Inthe Save Asdialog box, open the Save As Type drop-down list and select
* STL.

3. Click Options and set the following parameters:

O Total Quality—approximately 0.01 mm (deviation tolerance / linear-
dimension tolerance)

O Detail Quality—approximately 5° (angle tolerance)

Note: Lowering these values produces more accurate models, but results in
larger files and longer loading and processing times. For this reason, it is
generally not recommended that you use lower values.

4. Inthe file format option, choose binary or ASCII. (Both binary and ASCII
formats can be used in Objet Studio. However, binary files are smaller, so this
option is recommended.)

5. Click OK or Save.

After converting the model files, it is recommended that you check them for
defects before opening them in Objet Studio and producing the model. You can
do this in a third-party STL-repair application (such as Magics™, by
Materialise®).

For more information, download From CAD to Objet Studio Workflow for
PolyJet Technology.

Converting CAD Files to SLC Format

DOC-32020 Rev. F

When converting files to SLC format, it is recommended that you set a layer
thickness of 15 microns (0.015 mm). Since SLC files cannot be orientated in
Objet Studio, it is important that models are properly orientated before being
saved as SLC files. Considerations for suitable model orientation are explained
in "Manual Positioning" in Chapter 3 on page 5-22.
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Objet Studio Software

The Objet Studio program for the Eden260V 3D printing system consists of two
main screens:

* Tray Settings / Model Settings
» Job Manager

Tray Settings / Model Settings

In the Tray Settings and Model Settings screens, you prepare source files for
production in Eden260V 3D printers. Objet Studio offers you a wide variety of
file-preparation options, but always consists of the following basic procedure:

1. Placing one or more objects on the build tray
Positioning the object(s) on the tray

Configuring object and tray parameters

oD

Saving the tray configuration as an objtf (tray format) file

5. Sending the objtffile to the Eden260V 3D printer for production

Using Objet Studio to perform these tasks is described in detail in Chapter 5,
"Using Objet Studio".

Job Manager

The Job Manager screen is different for client workstations and for the computer
connected directly to the Eden260V 3D printer.

* In Objet Studio installed on the directly-connected computer (server), the Job
Manager screen displays the queue and status for all jobs sent to the 3D
printer by the server itself and by all client computers on the network. All jobs
displayed can be edited and manipulated.

* In Objet Studio installed on client computers, the Job Manager screen
displays the queue and status only for jobs sent to a 3D printer server from
that computer. Only these jobs can be edited and manipulated from the client
computer.

Client computers can be connected, via the local network, to PolyJet 3D

printers, but only to one at a time. The Job Manager screen displays the status
of the 3D printer to which the client is currently connected.
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How to Install Objet Studio

Objet Studio software is installed during printer installation. This section is
provided in case you need to reinstall Objet Studio, or install it on a remote (client)
computer.

The Objet Studio setup wizard guides you when installing this software. Objet
Studio is installed on the printer-server (“host”) computer, but it can also be
installed on remote, “client” computers and on computers used to prepare files
for printing models, or for training and demonstration purposes. During
installation, you choose to install either the printer-server (“host”) application or
the client application.

To install Objet Studio software:

1. Connect the USB flash drive (supplied with the printer) to a USB port.

2. Onthe USB flash drive navigate to the Objet Studio installation file, and runiit.

3. Toinstall Objet Studio, you must agree to the license agreement. After
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reading its terms, click Yes to continue, or No to close the wizard.
If you click Yes, the following screen should appear.

ObjetStudio - InstallShield Wizard et S

Please note...

er thiz Objet 5tudio installation.

Figure 4-1 Objet Studio compatibility check

Make sure that your printer is compatible with Objet Studio by checking the
list displayed.

Note: The printers displayed are legacy printers that are not compatible with
this version of Objet Studio.

4-2



Eden260V User Guide

4 Installing Objet Studio

DOC-32020 Rev. F

5.

In the Installation type screen, select the required installation option.

Select Objet Studio for a Server computer—

3 if you are installing Objet Studio on the server (“host”) computer—the
computer directly connected to an Eden260V printer.

3 if you are installing Objet Studio on a standalone (offline) computer.

Select Objet Studio for Client workstations if you are installing Objet
Studio on a “client” workstation—a remote computer that prepares print jobs
and then sends them to a server computer.

ObjetStudio - InstallShield Wizard X

Installation type

Figure 4-2 Objet Studio configuration selection
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6. Inthe Choose Destination Location screen, verify the destination folder and

click Next.

ObjetStudio - InstallShield Wizard

Figure 4-3 Objet Studio installation-folder selection

%( It is recommended that you do not change the default destination folder.

7. Inthe Select Printer Type screen, select the 3D printer used for producing

models and click Next.

ObjetStudio - InstallShield Wizard

Select Printer Type

Objet30 OnthaDesk

Eden2Blv

Eden50y

Eden500

Obijgt260 Connex

Obiet1000 Connexd

Figure 4-4 Printer selection

DOC-32020 Rev. F 4-4



Eden260V User Guide 4 Installing Objet Studio

8. When the following screen appears, click Install to begin installation.

ObjetStudio - InstallShield Wizard it

Ready to Install the Program
Th

Figure 4-5 Ready to Install screen

After clicking Install, a progress bar shows the progress of the installation
process.

ObjetStudio - InstallShield Wizard X

Setup Status

Cancel

Figure 4-6 Installation progress bar
%( Objet Studio requires that Microsoft® DirectX® is installed on the computer. If

necessary, an installation screen for this program will appear. To continue
with Objet Studio installation, accept the DirectX agreement.
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When installation is complete, the final InstallShield wizard screen appears.

ObjetStudio - InstallShield Wizard

InstallShield Wizard Complete

installed DbjetStudio.

Figure 4-7 Finalinstallation screen

9. To complete the software installation, click Finish.
The installation process ends when the appropriate icon(s) appear on the
computer desktop:

* Objet Studio
+ Stop Job Manager (for servers and standalone stations)

How to Uninstall Objet Studio

If there is ever a need to uninstall the Objet Studio software, do not attempt to do

so from the Windows Control Panel. (This does not completely remove all

software components.) Instead—

> From the Start menu, select All Programs > Stratasys > Uninstall Objet
Studio.
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Launching Objet Studio

"-. .

3

After you install Objet Studio, a launch icon éhﬂ! appears on the Windows
desktop. Open the application by double-clicking this icon, or by selecting Objet
Studio from the Start menu.

Objet Studio Interface

When Objet Studio opens, the Tray Settings screen appears, showing an empty

build tray.
o i e - '-':-If—’HeIp
DbjetStudio/" \\Standard
Commands e \

_ Active ribbon
Quick

Model tree
Job Manager

‘ d tab
4 4

Figure 5-1 Objet Studio opening screen
The Objet Studio interface consists of two main screens:

» Tray Settings—for arranging models and preparing them for printing.

* Job Manager—for monitoring and managing print jobs.

This screen is described in "Monitoring and Managing Print Jobs" on page 5-
65.

Each screen is controlled by menus and icons on its own ribbon. An additional
ribbon, Model Settings, displays controls for configuring and manipulating
selected models.

Objet Studio anticipates your workflow by displaying and enabling the options
relevant to your current task. For example, when you first open Objet Studio, the
Model Settings ribbon is disabled until you place a model on the build tray.
Similarly, options available from the standard toolbar menus are enabled or
disabled to match the current workflow.
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The ribbon, colors used, and several other interface features can be customized.
How to change the appearance of the interface is explained in "Customizing
Objet Studio" on page 5-52.

Instructions for using the commands for preparing models for production and
sending jobs to the printer, appear later in this chapter.

_.@‘1 i Objet Studio: Eden Loaded materials: FullCure720) =N
L

Arrange Tray Job Manager Edit ~ View ~ Object ~ Tools ~ Style ~ @ 4
- R G 3 || Y g ¥l Hg [ Hs FullCure720: | §
b ¥ 3608800 0 Q4 @ M om
Insert || Placement Validate Estimate Build || Plane || Mew Open Save || Undo Redo single Zoom Tsometric By FullCure720 ~ ||| FullCure705 $
View ~ Tray~ - Material *

Building Time: |§
Madel Tray Select File Edit View Color Tray Material Estimations are not available

Figure 5-2 Tray Settings ribbon

|© ¥ 7 ObjetStu... ‘Wrench Key - =@ x
Edit - Wew - Object - Toals - Style - @ -

Tray Settings Model Settings Job Manager
o Cut f K i f i 155,90 ") Uniform Scale mm g
o R ¢ B w e a @ & sl Conl (@l &
49 COPY  Delete Undo Redo Flane Move Transform Lock Single Zoom Isometric | 71 |[49.66 Millimeter | |Matte|Glossy Advanced By
Paste = Yiew T Tray = A 71 10,20 " Material =
Edit Selection Manipulate Wigw Dimensions (mm) Uniks Options Colors

Figure 5-3 Model Settings ribbon
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Ribbon Commands

The following table lists the Tray Settings and Model Settings ribbon command
groups, and shows when they are enabled, and where they appear.

Group Purpose When enabled | Tray Model
Settings | Settings
Ribbon | Ribbon

P

o Setting display colors. Always.
Matztual ~ J J

Colors

B & Selecting perspective Models are on
Soge  Zoon and zoom level. the build tray. J J

Choose to select a plane. | Models are on

the build tray. J ,[

(Y Change the perspective | Models are on

Isometic of the active pane. the build tray. J J
pt
5
=L
£
b=

@] HQ [F] HS Assigning printing Build tray is

FullCure720 - materials. empty.

Support SUPTO7 & p y J

Tray Materials Models are not
selected.

N Undoing or redoing After an action or

i actions. object selection. J J
vaohtes: 440 Estimating the amount of | Build tray is not
- printing materials empty.

required. 9[
D \b; 8 Opening and saving files. Z/Ie(?;j:tlzsre not J
New Open Save .
File
%0 Placing model files on the | Always.

Insert bU”d tray. J
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Group

Purpose

When enabled

Tray Model
Settings | Settings
Ribbon | Ribbon

. w &
¢ ¥ 99

Pre-build/build

Models are on

Placement valdate Estimate Buid commands. the build tray. ’/
% (3.60 %) Uniform Scale Setting model A model is
i il dimensions. selected.
2101 J
Dimensions {rmm)
k- N4 Cutting, copying, pasting | A model is
s and deleting models. selected. J
Ed
g 4 Moving, rotating and A model is
. > resizing models selected
M Trarsform  Lock 9 ) ’ J
T Assigning model finish A model is
9@ .
Rt ossy Advanced and setting support selected. J
strength/“hollow.”
mm Setting a model’s unit of | A model is
o measure (millimeters or | selected. J

£

inches).

To quickly identify an icon, move the cursor over it to display a tooltip. The “Undo” and
“Redo” tooltips change to reflect your last Objet Studio action.

After activating some of the ribbon commands (by clicking them), they remain active until
you click another button or until you press the Escape key.
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Objet Studio Commands Menu
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Clicking the © iconinthe upper-left corner opens the Objet Studio Commands
menu. This menu displays basic application commands and options.

Qo reis

\é: Wz Recent trays
E 1 bestiengn
@ Open...

| £ Traydd

‘é Sava

3 C\Program Fies)...\Tray3s
|

"O.é‘ Jave g... 4 Ci\Program Fies\...\Trayl

'é‘ Save fmap...Clri+b

"\%9 Import Packed Job..,

@, Expart Packed Jab...

@, Build Properbes. ..
-
KE User Preferences...

:& Prinber Properties...

Restart

Codfes |

Figure 5-4 Objet Studio Commands menu
The Options button opens a dialog box for customizing Objet Studio.

Options

| Appeararice || Grid | Manipulats | Display | Settings -.
Autornatic Placement
Quick Autornatic Placement sfter adding new object

Pieserve 1 mm  distance betwesn objects

Automalic Lay On [Gravily)

O Never
() Blways
(3 when under the tray

Latge Files

() Load Full
) Load Pattial [reduced)

Load Search Order
O Local
© g

[x]

I ok I[ Cancel ]

Apply

Figure 5-5 Options dialog box
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Model Tree Pane

The Model Tree pane lists the objects placed on the build tray. By default, the
pane “floats”™— that is, you can move it to another position on the screen and

resize it. Alternatively, you can fix its position at the left of the application window,
and even hide it.
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Preparing Models for Production

Model preparation involves the following basic steps:

1. Place objects on the build tray.

2. If necessary, manipulate the object’s orientation and position.
3. Select the material and model finish.
4

. Select the materials and model finish.

OBJDF Files: Overview

An objdffile describes both the geometry of a single object and the material, and
finish required to print it.

You can use this file format to save a group of separate objects on the build tray
as one unit, together with their relative positions and material.

Further explanations of objdffiles, and their features, appear throughout this
chapter.

Model Files

To produce models, you open one or more model files in Objet Studio and
position objects on the build tray. You can place objects on the build tray in two
ways:

* by inserting individual st/files.

* by pasting objects that you copied to the Windows clipboard.

If you know what type of model material will be used to produce the models,
make sure it is selected from the material drop-down menu.

FullCure720 -

[] Fulicure720
. YeroBlack

Figure 5-6 Model material selection toolbar

Note: Itis not necessary to select the Model material now, but it is
recommended—each type of material has unique characteristics that may affect
the valid positioning of objects on the build tray.
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Placing Objects on the Build Tray

To place an object on the build tray:

1. Open the Insert dialog box—
O Fromthe Object menu, select Insert.

or—

O Onthe Tray Settings ribbon, click Insert
or—

O Right-click on the build tray, and select Insert from the context menu.
The Insert dialog box appears.

Look in: _-_} Sample: w 2 ¥ A
ay .._']Basn: Shapes
£) Chess

Iy Recent ) Connex Samples
Documents CConnes_Samples

= JEden_slaris_Samples
\ ’?} ) Imapas

Diesklop CDSLE e

J5TL Fias
) Texk3D
..-J L Trayl
My Documerts @
iy i:un'nuher
i:g File name: _sample file il
My MNetwork File= of bype: STL Files [*stl) L Cancal
Unitz: ditdater bl
Mumber of Copiez: |1 = E] [+] Drierk Automatical
Coordnates
Width (<] Depth[¥]  Heaht 2]
Euterits 2249 h0.2318 229

[+] Freview

Figure 5-7 Insert dialog box
2. Inthe Look in field, display the appropriate folder.
3. Inthe Files of type field, select the file type to display.

4. Selectthe desired file, and make sure that it appears in the File name field.
If the Preview check box is selected, the object is displayed in the dialog box,
as shown in Figure 5-7.

The Model Settings ribbon is displayed when objects are placed on the build
tray.
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5. Select any of the following options, as required:
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O Units—Millimeters or inches for the object’s units of measure.

The 3D file contains the object's proportions, but not its units of measure.
Therefore, make sure to correctly select either millimeters or inches
when inserting an object. Otherwise, the size of the object on the build
tray will be either much too large or much too small. To change the
measurement units of objects already placed on the tray, see
"Measurement Units" on page 5-27.

O Number of copies—How many copies of this object to place on the build
tray.

O Orient Automatically—Automatically orient objects on the build tray for
efficient model building.

Note: The Extents values displayed in the Coordinates section of the Insert
dialog box, represent the maximum dimensions of the object on each axis.
These dimensions correspond to the virtual “bounding box” surrounding the
object see Figure 5-33 on page 5-34).

Click Insert.
Objet Studio places the object on the build tray, and in the model tree.

v Bedd - et Crdrikes b £1 SAusier CDEN
Ty Soetigs M et gE LTI [
Poe M NN F Ry B @ ¢oew P L= () £
Mode L T Mae | Pe baeen s VOEN ﬂ | E—
Pete = E Huoé
-FIJ—;.::! \ [ e, My s T —— s Ograns

Meauadel Tree |

Trarl \
| et i

Modsl
Toolbar —

Figure 5-8 Default screen layout

The Model Settings ribbon is displayed when objects are placed on the build
tray.
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If the object is over a certain size, the Loading Placed Elements dialog box

appears.
Loading Placed Elements E|
tadel Mame |\ AGRendsrBinhTrayl . objtf

[ )

Flaced Element  |C:h... Stestbuild.objdf

[ ]

|
Figure 5-9 Loading Placed Elements dialog box

You can speed up the opening of large files by changing the Large Files
settings—see "Loading Large Files" on page 5-38.
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Opening objdfFiles

Before placing objdffiles on the build tray, Objet Studio must extract the
component st/ files together with information about their relative position and

model materials. To do this, Objet Studio creates a folder with the same name as
the objdffile, in the same location.

If you are opening an objdffile, the Insert dialog box also includes a Materials

field that shows the object’s printing material assignment (see below).

) # = @

Look in: | ) Samples

&

My Recent
Documerts

=

=
cn
21
&=
=1
b=l

%

My Documents

& je

My Network,

v

|=) Basic Shapes

|0 Chess

|5) Connex Samples
|C5) Connex_Samples
|C3)Eden_alaris_Samples
) Images

|5 sample File
I)5LE Files

) STL Files

103 Tewkal

) Travl

b vy

Filz name; |Tray‘|

hd | [ Inzert l

Files af type: | Obijet Digital Files [*. objdf)

v | [ Cancel ]

Uris: Millitd eter hd

F [] Orient Automaticaly

MNumber of Copies : |1

Coordinates

Yidth ()
E stents

I aterials

Depth [¥]  Height [£]

Packed Aszzembly File

Yerowhite

Preview

Figure 5-10 Insert dialog box (objdffile)

A warning message appears if a part is defined with materials not supported

by your system, or if an object already on the build tray uses different

materials.
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Opening Objet Tray Files

You can open trays that were saved as objtffiles. (Saving objtffiles is described
in "Saving Build Trays" on page 5-50).

To place an object saved as an Objet Tray File (objtf) file on the build
tray:

1.

=

From the File group, click o,
or—

From the Objet Studio Commands menu O , select Open.

The Open dialog box is displayed.

Open @El
Laok in: | I Basic Shapes v Q il
Y (5 e
> omm

tdy Recent
Documents

Deskiop

tdy Documents

-
0L
tdy Computer
‘,} File name: Trapl b
2
My Network | Files of ype: Objet Tray Files [*.obitf] ~

Coordinates

Preview

Figure 5-11 Objet Tray File Open dialog box

Select the desired file, and make sure that it appears in the File name field.
If the Preview check box is selected, the object is displayed.

Click Open.
Objet Studio opens the tray file.

%{ The opjiffile is actually a file containing instructions for printing—which st/ files
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to print and their position on the build tray. Because the objtffile references
the stlfiles used, they must remain in the same file location as when the objtf
file was saved.
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STL file loading preference

If there are identically named st/files in more than one location, you need to
ensure that the correct component st/ files are linked to the objtffile. For example,
if there are identically named st/files on one drive and on a flash drive (this can
occur if you copy the original files to a working folder), you can set the default
location from which files are loaded.

To set the Load Order:

1. From the Tools menu, select Options.
or—

In the Objet Studio Commands menu © , click Options.

2. Inthe Options dialog box, display the Settings tab.

Options §|

Appearance || Grd Manipulate | Display | Settings

Autornatic: Placement

Quick Automatic Placement after adding new object

Preserve 1 mrn distance between objects

Autornatic Lay On [Grawity]

() Newer
(%) Alwayz
1 when under the tray

Large Files

(%) Load Full
(") Load Partial

nad Search Order
() Local
(%) Original

I Ok l[ Cancel ]

Figure 5-12 Options dialog box, Settings tab

3. Under Load Search Order, select an option:
O Local—to load files from the location where they were last saved.
O Original—to load files in their original location.

4. Click OK.
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Quick-Access Model Commands

You can access common commands for working with objects on the build tray
with the convenient Model Toolbar and context menus.

Model Toolbar

Select an object in the tray to display the Model Toolbar that contains icons to
perform common tasks.

%S|
LR AL

Figure 5-13 Model Toolbar
The table below describes the Model Toolbar icons.

Icon Description
- Applies a matte finish to the model.
o Applies a glossy finish to the model.
&z Opens the Advanced Properties dialog box for setting the Grid
Style and the Hollow option.
xf-:'*'- Enables dragging an object (see page 5-29).
.

Opens the Transform dialog box for changing the object’s
position and scale.

i1} Toggles the Lock Model Orientation setting.

Right-click model menu

If you right-click on an object, a pop-up context menu is displayed from which you
can also select the model finish, change its position and scale, and set the Grid
Style and Hollow options.

QE{ You can also create a Quick Access toolbar with your most commonly used

icons grouped together. See "Creating a Quick Access Toolbar" on page 5-
52.
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Selecting Objects

To manipulate an object on the build tray or assign characteristics to it (building
style, for example), you must first select the object. You select an object by
clicking it, either on the tray or in the model tree. Its image on the build tray
changes color (to light blue, by default) and its name is highlighted in the model
tree. You can select multiple objects by drawing a box around them with the
mouse cursor, or by pressing the Ctrl or Shift keys while clicking additional
objects.

Alternatively, select or de-select objects using the following Edit menu
commands:

» Select All
* Invert Selection

» Undo Select object

Edit - Miew = Object -

A Undo Select object

Select Al

Inverk Selection
Figure 5-14 Edit menu

Copying and Pasting Objects
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If you need to duplicate objects on the build tray, you can insert the same object
from its file more than once. An easier way, however, is to copy and paste the
object. You can copy objects from the build tray or the model tree. The objects
copied remain in the Windows clipboard until you paste them onto the build tray.

You can also copy objects from one tray and paste them onto another, in the
same way as you copy text from one document and paste it into another one.
However, Objet Studio allows only one tray to be open at a time. For each build
tray you need to work with (at the same time), you must open a separate Objet
Studio window, by running the application again (from the Windows Start menu).

Having multiple Objet Studio windows open can be convenient when you
need to manipulate or configure objects before inserting them in your
production build tray. Copying and pasting also allows you to use objects
already configured on previously-used build trays for newer projects.

You perform the Copy and Paste commands as in other Windows applications:

« from the right-click context menu.
* by using keyboard shortcuts (Ctrl+C and Ctrl+V, respectively).
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The Paste Special command (from the object’s right-click context menu) enables
you to place duplicate objects even more efficiently:

* You can specify the number of duplicates to place on the build tray at once.

* You can set the distance, on each axis, between the duplicate objects.

* You can manipulate mirror images of the original object, and flip them on
selected axes.

Paste Special §|

Mumber of Copies 5
Delta
100 Y100 Z |0 T

M anipulate
Mirror [F = N =
Flip |3 Wy |[dz

[ 5ave as Defaults [ k. l [ Cancel

Figure 5-15 Paste Special dialog box

Surface Finish

Models can be printed with a matte or glossy surface finish. To create a matte
finish, the printer surrounds models with a thin layer of support material.

To set the model finish:
1. Select the model.

2. Select Matte @ or Glossy < inone ofthe following places:
O Model Settings ribbon, Options group
O Model Toolbar

3 right-click context menu (when selecting the model)

You can configure Objet Studio to distinguish between objects’ surface finish on
the build tray by color. To configure how Objet Studio displays objects, see
"Setting Object Colors" on page 5-37.
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Positioning Objects on the Build Tray

To produce models efficiently and with the required finish, it is important to
carefully position objects on the tray. Objet Studio supports the automatic
positioning of objects. However, you should check to make sure that the objects
are orientated optimally for your needs, according to the considerations
explained in "Manual Positioning" on page 5-22.

Two things that affect the positioning of objects on the tray are orientation and
placement. You can let Objet Studio determine the optimum orientation and
position, or you can control them.

Automatic Orientation

By default, Objet Studio automatically orients objects, when placed on the build
tray, for the shortest printing time. (You can later change the orientation
manually.) However, you can cancel automatic orientation when placing an
object on the build tray.

To place an object on the build tray without automatic orientation:

> Inthe Insert dialog box, make sure Orient Automatically is not selected.

Look in: | I3 Samples v Q9 ¥ = -
3 |Z)Basic Shapes
4 :3 ) Chess
My Recent ) Connex Samples
Documents |23 Connes:_Samples
= |)Eden_alaris_Samples
L% ) Images
Deskiop |y sample file
IZ)5LC Files
I)STL Files
| Text3D
My Documents %Trayl
o Trayl
-
59
My Computer
‘_;] File name: Trayl A
2
My Network  Files of type: Obiet Digital Files [* obidf] v
Urits: Millitd eter v
Mumber of Copies : |1 e E] [ Orient Automaticaly
Coordinates
Width (] Depth [v)  Height [£)
Extents
I aterials
Packed Azzembly File
Wercwhite
Preview

Figure 5-16 Orient Automatically option disabled

%{ You can change the default setting, so that automatic orientation is not
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applied unless you select the Orient Automatically check box each time you
place an object on the build tray. To do this, see "Default Settings" on page 5-
59.
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Automatic Positioning

After placing several objects on the build tray, you can let Objet Studio arrange
them before printing. This ensures that the objects are positioned properly, and
that they will be printed in the shortest time and with a minimum of material.

To automatically arrange objects on the build tray:

> Onthe Tray Settings ribbon, click e
or—

From the Tools menu, select Automatic Placement.

The effects of automatic positioning are shown in the figures below.

Figure 5-18 Tray arrangement after applying Automatic Placement

« Forbest results, arrange the tray with Automatic Placement,on the
TraySettings ribbon, even if you inserted the objects with the Orient
Automatically option.

« The physical characteristics of each type of Model material you use can
affect the positioning of objects on the tray. Therefore, select materials
before running Automatic Placement.
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Manual Positioning

You can change the position of objects on the build tray—even if they were
inserted with the Orient Automatically option. Tools for changing the position of
objects are presented in "Manipulating Objects on the Tray" on page 5-24.

The orientation of models on the build tray affects how quickly and efficiently they
will be produced by the printer, where and how much Support material is used,
and whether or not model parts will have a glossy finish. Therefore, you should
consider a variety of factors when deciding how to place models on the build tray,
using the following positioning rules.

X-Y-Z Rule
This rule considers a model's outer dimensions.

> Since the print heads move back and forth along the X-axis, the printing time
along this axis is relatively short, compared to printing time along the Y-axis
and Z-axis. From this point of view, it is advisable to place the object's largest
dimension along the X-axis.

> Surfaces that come into contact with Support materials become matte.

> Since models are built up, on the Z-axis, in 16- or 30-micron layers (according
to the printing mode), it is very time-consuming to print a tall object. From this
point of view, it is advisable to place the object's smallest dimension along the
Z-axis.

> Since the print heads measure about 2 inches (5 centimeters) on the Y-axis,
models measuring less than this (on the Y-axis) are printed in one pass. From
this point of view, it is advisable to place the object's intermediate dimension
along the Y-axis.

Tall-Left Rule
This rule considers models where, after being orientated on the build tray
according to other considerations, one side is taller than the other.

> Since the print heads move along the X-axis from left to right, taller sections
on the right require the print heads to scan unnecessarily from the left until
reaching them. If, on the other hand, the taller sections are positioned on the
left of the build tray, the print heads only have to scan the model until printing
these sections—once the lower parts have been completed. Therefore, you
should position the taller side of the model, when possible, on the left.

The following rules are based on the fact that Support material is not required
on the top of the printed model.

Recess-Up Rule
This rule considers models containing surface recesses.

> Recesses in the surface (like hollows, drill holes, etc.) should, when possible,
be positioned face-up.
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Fine-Surface Rule
This rule considers models that have one side on which there are fine details (like
the keypad side of a telephone).

> The side of the model containing fine details should, when possible, be
positioned face-up. This results in a smooth finish.

Avoid Support-Material Rule

This rule considers models that have large holes or hollows, open on at least one

side (like a pipe or a container).

> It may be advantageous to print a model standing up, so Support material
does not fill the hollow, even though printing the model lying down would be
much faster.
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Positioning Objects on the Z-Axis

When you use the automatic positioning option to arrange objects on the build
tray (see "Automatic Orientation" on page 5-20), the objects are positioned
directly on the tray. If you do not insert objects with automatic positioning, they
often appear either above or below the tray.

In practice, the Eden260V system prints all models on the build tray on a one-
millimeter bed of support material. The importance of positioning objects
directly on the build tray with Objet Studio is to correctly display the objects on

the screen.
To position objects directly on the tray:
1. Select the object.
2. From the Object menu, select Lay On.
To ensure that objects are always positioned directly on the tray:

1. Fromthe Tools menu, select Options, and display the Settings tab.

| Appearance || Grid | Manipulsle | Display | Settings

Automabic Placement
Quick Autornatic Placement after adding new object

Pieserve i mm  distance between objects

Autornalic Lay On [Gravily)
(O Newer

() Blways

(3 wWhen under the tray
Large Files

() Load Full
() Load Partial [reduced)

Load Search Order
O Local

[ 18 l[ Cancel ] Apply

Figure 5-19 Options dialog box, Settings tab
2. Inthe Automatic Lay On (Gravity) section, select Always.

Other Z-axis options (in the Automatic Lay On section):

* When under the tray—The display of objects that are below the build tray is
automatically changed so that the object is at tray level.

* Never—The display of objects that are above or below the build tray is not
changed.
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Valid Object Placement

You can ensure that models do not overlap when you position them on the build
tray, and that they do not extend beyond the tray.

To ensure valid object placement:

1. Fromthe Tools menu, select Constraints Settings.

B)
Constraints
Colars
Drefault Color
Outzide Tray

Callision

iin

Bath

Dynamic check
when to check

(® On Diop
(O \while Drag

Wwhat to check
Outzide Tray
Object Collizion

Figure 5-20 Constraints Settings dialog box

2. Select Dynamic check to identify—

3 invalid object placement while placing objects—On Drop selected.
invalid object placement after moving objects—While Drag selected.
objects placed beyond the tray’s boundaries—OQutside Tray selected.
objects that overlap—Object Collision selected.

aaaqa

% Even if you do not use Dynamic Check when placing objects on the build tray,
Objet Studio automatically checks if there is a problem with the positioning of
objects on the tray before sending it to the printer. You can also manually

check for problems after positioning objects (see "Tray Validation" on page 5-
42).

Note: Remember that Objet Studio calculates the space occupied by an object
including the “bounding box” surrounding it (see Figure 5-33 on page 5-34).
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Using a Grid to Position Objects

Displaying a grid on the image of the build tray can be useful when positioning

objects. To use the grid features, select the following menu options.

Menu Option Result
Tools > Grid Displays a grid on the build tray.
Tools > Snap to grid When moving the object, it aligns with the nearest grid line.
Tools > Options > Grid Enables you to change the grid origin
(X- and Y-axis meeting point) and appearance.
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You can review and configure grid settings—and apply them—from the Options

dialog box.

To view and change grid settings:

1. Fromthe Tools menu, select Options, and display the Grid tab.
The current grid settings are displayed.

Options g]
Appearance | Grid Manipulate | Display | Settings
[ Display grid
[] Shap to grid
Colars
Tile size 20 = mm
Baze -
Major divisi 10 > | tib
ajor division ilez Bt -
MNumber of tiles |32 £
Major -
Line style Dot
Units Millitd eter v
Origin 1] >0 >0 % |mm
[ Ok ] [ Cancel ]

Figure 5-21 Options dialog box, Grid tab

2. Asrequired, change the settings, and select or clear the check boxes.

3. Click Apply or OK.
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Measurement Units

3D files contain an object's proportions, but not its units of measure. Therefore,
make sure to correctly select either millimeters or inches when inserting an
object. Otherwise, the size of the object on the build tray will be either much too
large or much too small.

To set the measurement units when inserting an object:

> In the Insert dialog box, Units field, select Millimeter or Inch:

Loak in: | I3 Samples w | Q2 o
EY [)Basic Shapes
| :; ichess
Iy Recent I Connex Samples
Documents | Connex_Samples
i [C)Eden_slaris_Samples
=
U_% @Images
Desktap [C)sample file
I)5LC Files
. [C5TL Files
,.] [ Textan
tdy Documents oyt y
(D sample file
Iy Camputer
'7_- File: narne: | v | [ Ingert ]
My Metwork Filez of type: STL Fi )

Urits:
Figure 5-22 Unitsfield in the Insert dialog box

To change measurement units for a selected object from the
Model Settings ribbon:

1. Open the Units flyout toolbar.

mm
=
Millirneter

m iks
inch

Figure 5-23  Units flyout toolbar

2. Select the measurement units desired.
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To change measurement units for a selected object from the standard
toolbar:

1. From the Object menu, select Change Units.

Model Units

Units | MiliMeter v ok |

Ihich

Figure 5-24 Model Units dialog box
2. Inthe Model Units dialog box, change the setting and click OK.

Setting Model Dimensions

You can change an object’s dimensions by changing its size on the X-, Y-, and Z-
axes, from the Dimensions group on the Model Settings ribbon.

¥: |3.60 «. ) Uniform Ecalai
i 416
Z: 1.01

Dimensions {mm)

Figure 5-25 Dimensions on the Model Settings ribbon

« If Uniform Scale is enabled, changing the object’s dimension on one axis
affects the other dimensions, proportionately.

« After changing a measurement, press Enter or click in another field in the
Dimensions group.

Note: You can change the height of the objects on the build tray only if this is
allowed by the Objet Studio settings (see "Positioning Objects on the Z-Axis" on
page 5-24).
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Manually Repositioning Objects
You can manually move and rotate an object on the build tray with the arrow
keys, or by dragging it with the mouse.

To manually manipulate an object:

1. Select an object by clicking it on the build tray, or in the model tree pane.

2. Click E on the Model Toolbar, or on the Model Settings ribbon.

A frame appears around the object, and the cursor changes to indicate that
the object can be moved.

Figure 5-26 Manually moving an object

3. Ifyou click on a corner of the frame, the cursor changes to indicate that the
object can be rotated.

Figure 5-27 Manually rotating an object

4. Manipulate the object with the arrow keys or with the mouse.
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Using the Transform Dialog Box
You can make precise changes to an object by changing the properties in the
Transform dialog box.

To access the Transform dialog box (when an object is selected):

* Click g on the Model Toolbar or on the Model Settings ribbon.
» From the right-click context menu, select Transform.

» From the Object menu, select Transform.

Transform E|
Width[] Depth(v']  HeightZ)

Translate: | 0 2 I =

Ratate: iy = gy a =

Scale: I i 1= [ =

Urifarrn Scaling | Apply | | Heset |

| Cancel Actions |

Figure 5-28 Transform dialog box
To change an object with the Transform dialog box:

> Change any of the values, then click Apply to see how the object changes on
the build tray.

Note: The changed values remain in the dialog box after clicking Apply.
Therefore, you can make small changes to values in the dialog box to see how
the object changes on screen each time you click Apply.

To reset all of the values in the dialog box:

> Click Reset.

Note: The object does not change. Any changes previously applied remain.
To undo all changes made with the Transform dialog box:

> Click Cancel Actions.

After closing the Transform dialog box, clicking Undo (on the Model Settings
ribbon or from the Edit menu) cancels all changes made with the dialog box.
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Changing an Object’s Orientation

There are several methods for changing the orientation of objects on the build
tray.

To rotate an object:

> Select the object and use the Object menu options (see also "Manually
Repositioning Objects" on page 5-29).

To re-align an object’s plane:

*

Plane

1. Onthe Tray Settings or Model Settings ribbon, click e,
or—

From the Tools menu, select Plane Alignment > Select Plane.

2. Click on part of an object on the build tray.
The selected plane is displayed.

BN
ek

Alignment
toolbar

Selected
plane

Figure 5-29 Aligning by plane
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3. Onthe Alignment toolbar, click an appropriate icon to change the alignment.
or—

From the Tools menu, select Plane Alignment, and select an alignment
option.

Plane Alignrent M| < Select Plane
v | Professional Mode =i Align Bokbarn
*=  plign Top
v Align Eronk
fssembly Map ... _
* 1 align Back
Language. ..
=anguag 5 align Lefr
Cptions...
= T align Right

Figure 5-30 Tools menu, Plane Alignment options
To cancel plane selection after re-aligning objects on the build tray:

L3

Flane

> Onthe Tray Settings or Model Settings ribbon, click seeen .
or—

> From the Tools menu, select Plane Alignment > Select Plane.

To flip an object 180 degrees on any axis:

1. Select the object.

2. Fromthe Object menu, select Flip > Flip X/ Flip Y / Flip Z.

To make precise changes to the object’s orientation on any axis:
1. Select the object.

2. Display the Transform dialog box (see Figure 5-28 on page 5-30).

3. Change the Rotate parameters for each axis.

Freezing Model Orientation
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If you manipulate an object on the build tray, you can freeze its orientation so that
it does not change when you position it automatically (see "Automatic
Positioning" on page 5-21).

To freeze an object:
1. Select an object on the build tray.

2. Onthe Model Settings ribbon, in the Manipulate group, or on the Model
Toolbar, click & .

To unfreeze an object:

> Select the object and click # (to de-select it).
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Display Options
Viewing Objects

From the View menu, you can change the way objects are displayed. The default
method for displaying models on the build tray is as solid (“shaded”) objects.

Figure 5-31 Tray and model displayed in Shaded view
The other display options are WireFrame and Points.

To display the build tray in WireFrame view:

> From the View menu, select WireFrame.

Figure 5-32 Tray and model displayed in WireFrame view

To revert to the shaded view:

> From the View menu, select Shaded.
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To display objects as boxes, showing their maximum dimensions
instead of their shape:

> From the View menu, select Display Bounding Box.

I"‘;

Figure 5-33 Model displayed with bounding box

To display the area around objects needed for support material (to
produce a matte finish):

> From the View menu, select Display Thickening Box.

Figure 5-34 Model displayed with thickening box

To display the maximum build height:
> From the View menu, select Display Tray 3D Box.

Figure 5-35 Tray 3D Box

To display objects without the build tray:

> From the View menu, clear (de-select) the Display Tray option.
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Screen Layout

DOC-32020 Rev. F

Objet Studio automatically adjusts the default screen layout to display the
optimum views of the build tray and the model tree. You can view models from
different perspectives by changing the screen layout.

To change the screen layout:
> On the View flyout toolbar, select Single View, or 4 Views.

Figure 5-36 Screen layout icons
3 Single View (il is the default screen layout.
3 4 Views displays perspective, top, front and right views.

S

e ——
s - i i

Figure 5-37 Single-view screen layout

Figure 5-38 4-view screen layout
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Tray Perspective

The default perspective of the build tray is “isometric.” You can change the
perspective of the active window with one of ten options.

To change the perspective of the build tray in the active window:

1. Onthe Tray Settings ribbon, open the Perspective flyout toolbar.

Isometric

Figure 5-39 Perspective toolbar

2. Click the icon that represents the desired perspective.

Tray Positioning
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To view the tray and models from different directions, you can move the tray
around the screen and change its display angle.

To move the tray in the Objet Studio screen:

> Press the mouse wheel while moving the mouse.

ey [ ™

Figure 5-40 Tray after moving it in the Objet Studio display
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To manually rotate the tray:
> Press Alt and press the mouse wheel while moving the mouse.

-
h-}\
]

Figure 5-41 Tray after rotating it upside-down

To view the tray and models from different directions, you can change its display
angle.

Setting Object Colors

The color of objects on the build tray can indicate how they are printed. Objet
Studio enables you to choose the color display so that you can easily see the
material, and surface of objects.

To choose how colors are applied on the display:

> On the Model Settings ribbon, in the Colors group, select one of the options
from the flyout toolbar.

By

Ma;erial/c-::lor indicates Model
_?,i%,*;/{:olor indicates Model

Figure 5-42 Colors display options

% Before sending a build tray to the printer, or when you perform tray validation,
Objet Studio checks if there is a problem with the st/files or the positioning of
objects on the tray. If so, the affected objects are displayed with special colors
(see "Tray Validation" on page 5-42).
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Loading Large Files

Very large stlfiles can be slow to load and may be difficult to manipulate easily on
the build tray. If this is the case, you can display just an image of the object on the
build tray without loading the entire file. The st/ file itself is not changed, and the
complete file is sent to the printer.

To display an image of stl files when you place objects on the build tray:

1. From the Tools menu, select Options, and display the Settings tab.

Options rX |

| Appeaiance Grid | Maripuiale | Disslay | Seltngs |
Autematic Flacemenk
Quick Auloratic Flacsment alter adding new chiject
Pleserve Il mm  distance bebween objects

Auteenatic Lay On [Gravily)
O Mever

) Blways

Crwhen unde the Iray

Large Files

O Load Full

(%) Load Partial [reduced|

Load Search Urder

O Local

Sou

Figure 5-43 Options dialog box, Settings tab
2. Inthe Large Files section, select Load Partial (reduced).

Large File Manipulation

If you need to work with a detailed model that is composed of a large number of
polygons, you can speed up its display and manipulation in Objet Studio by
reducing the number of polygons on the screen. Although this may reduce the
resolution on the screen, it has no affect on the printed models.

_—

Figure 5-44 Object displayed without polygon reduction
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Figure 5-45 Object displayed with only five percent of its polygons
showing

To use polygon reduction:

1.

From the Tools menu, select Options.
or—

From the Objet Studio Commands menu (&) , Click Options.

In the Options dialog box, display the Display tab.

Options |z|

| Appearance || Grid || Manipulate| Display |Settings|

[[] Enable Polygon Reduction
Dizplay while changing wiew
(® Bounding Box

Adaptive Polygon Reduction
() Entire Object

Diizplay when static view
O Bounding Box

Paolygon Reduction [Percents]
(%) Entire Object

Save Polpgon Reduction Data
Default

[ QK _H Cancel ] Apply

Figure 5-46 Options dialog box, Display tab
Select Enable Polygon Reduction.
Select Polygon Reduction (Percent).

Enter the percentage of total polygons to display.
When you click Apply, the display changes.

Note: The setting affects the static display (when the object is not being
moved).

Set display options when the object is being moved (Display while changing
view):
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7.

8.

O Bounding Box—A box representing the object’s maximum dimensions is
displayed.

O Adaptive Polygon Reduction—Varying degrees of polygon reduction are
applied, as necessary.

O Entire Object—No polygon reduction is applied.

To save these settings, so that they will be applied every time you place this
object on the build tray, click Save Polygon Reduction Data.

Click Apply to see the results of the settings without closing the dialog box.

% Selecting the Entire Object option cancels polygon reduction.

Object display options

Zoom Options

DOC-32020 Rev. F

The display format affects how quickly objects display. For example, if you select
Bounding Box, objects display faster than they do when you select Entire
Object. You can choose display formats for objects when they are stationary
(static view) and for when you are dragging them (changing view).

To select the object display preference while changing view, and in
static view:

1.

Select to display objects:

O With a Bounding Box (see Figure 5-33 on page 5-34)
O With Adaptive Polygon Reduction (changing view only)
O With Polygon Reduction (static view only)

O Entire Object

Click OK when done.

While manipulating objects, you often need to view them at different zoom levels.

To change the zoom level:

> On the ribbon, open the Zoom flyout toolbar and select an option:

Zoom
Zoom Tray

Zoom by
Rectangle

Figure 5-47 Zoom flyout toolbar

O Zoom Object focuses on the selected object.
O Zoom Tray displays the whole tray.
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O Zoom by Rectangle allows you to display a section of the tray by selecting
it with the mouse.

You can also zoom in and zoom out with the mouse wheel.

You can configure Objet Studio to automatically zoom in on the objects
placed on the build tray. See "Automatic Zoom" on page 5-60.
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Handling Trays

Tray Validation
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After preparing models on the build tray, you can do the following:

* Test that it can be printed ("validation").

+ Calculate the time and material resources needed to print it.
» Send it to the printer for production.

 Save it for later completion or printing.

» Save it as a compressed file for convenient storage and transfer.

Before sending a job to the printer for production, you should check that the tray
is “valid” and can be printed.

To validate that the tray can be printed:
¥
> Onthe Tray Settings ribbon, in the Build Process group, click wsidses
or—

From the Tools menu, select Placement Validation.

If the tray is not valid, the color of the problematic models on the tray changes
according to a pre-set code.

x)
Constraints
Colars
Default Color
Outzide Tray

Callision

iin

Bath

Dynamic check
when to check

(® On Diop
(O \while Drag

Wwhat to check

Outside Tray
Object Collizion

Figure 5-48 Color code
Note: The “Both” color also indicates a problematic st/ file.

The validation status appears on the bar at the bottom of the screen.

VWalidation succeeded Maodels: 1

Figure 5-49 Validation details in status bar
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High Quality/Speed Setting

When preparing models, Objet Studio allows you to choose the quality/speed
setting most suitable for your job.

HQ (High Quality)—

* Prints models in 16-micron layers, suitable for producing fine details and
delicate items.

» Requires much more time to print most trays, compared to High Speed
setting.

HS (High Speed)—
* Prints models in 30-micron layers, suitable for producing larger models.

» Requires much less time to print most trays, compared to High Quality setting.
Change the setting, if necessary, before sending the tray to the 3-D printer.

v HG H5
FullCure7 20 v

Support SUPTOT

Tray Materials

Figure 5-50 Quality/speed setting

Production Estimates
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Objet Studio enables you to calculate the time and material resources needed for
producing trays before sending them to the printer. The time it takes Objet Studio
to perform this calculation depends on the number of objects on the tray and their
complexity. Calculating the production estimate for a full tray could take up to 15
minutes, depending on your computer’s specifications.

To calculate the time and materials needed for producing the current
tray:
> Onthe Tray Settings ribbon, in the Build Process group, click Estimats ,

While the estimate is being calculated, a progress bar is displayed—on the
right side of the status bar (at the bottom of the screen).

TIIIIIIL % —Cancel

Figure 5-51 Estimate progress bar

When Objet Studio finishes calculating the production resources, the results
are displayed in the Estimated Consumptions group on the Tray Settings
ribbon.
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Yerowhike: 38.0
Suppork: 270
Building Time:  |00:23

Estimated Consumpkions

Figure 5-52 Production resource calculation
E-mailing Objet Digital Files

You can easily e-mail objdffiles using Microsoft® Office Outlook®. Sending objdf
files is recommended (instead of st! files) because the size of afile is typically
reduced by more than half. An added benefit is that the objdffile contains the
model-material information for the object.

To e-mail a file:

1. Fromthe Tools menu, select Email Objet Digital File.

Outlook opens with the file attached and Subject details added to the e-mail
form.

2. Enter the e-mail address and send the file.

Printing the Tray

When a tray is ready to be printed, it is placed in the Jobs Queue. When the job
reaches the head of the queue, Objet Studio pre-processes the tray file to create
slices, and feeds them to the printer.

To send the tray to the print queue:

> On the Tray Settings ribbon, Build Process group, click Buid )

> Click Build and continue on the next page
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If the build tray file has not been saved when you click Build, the Save As
dialog box opens for you to save it.

Objet Studio checks if there is a problem with the positioning of objects on the
tray. If so, the affected objects are displayed with special colors (see "Tray
Validation" on page 5-42), and a warning message appears.

Warning

Overlapping objects!
- Click Mo to separate objects manually
or with Automatic Placemert.

- Click Y'es to print the tray az is.

Do you want to proceed anpway?

Figure 5-53 Tray validation warning message
> To cancel the Build command so you can correct the problem, click No.
> To print the models as they are positioned on the tray, click Yes.

The Job Manager screen opens, so you can monitor the progress of your
trays—before, during, and after printing. See "Monitoring and Managing Print
Jobs" on page 5-65.
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Applying Additional Objet Studio Features
Dividing Objects

You can use the Split Object feature to produce objects larger than the tray area
by dividing the model into separate parts. With this feature, you produce only a
specific section of a model.

To split an object:

1. Select the object.
2. Fromthe Object menu, select Split.

3. Inthe Split Object dialog box, enter the values to determine how Objet Studio
will divide the object. You can divide an object along any of its axes, by
entering either exact measurements or the number of parts.

Model Tree

Q Trayl
- _| Applications - FLUTE_Shell3_Part1
| applications - FLUTE_shell3_Part2

Object Size 315 228 22 6048

() Split by Size 347 347 202 Default
O Spltby Humber

Figure 5-54 Split Object dialog box
4. In Save to Folder, enter the folder name.

5. Click OK.

The composite parts are saved as new st/ files with “Part 1,” “Part 2,” etc.,
added to the original file name.

Note: Before printing the newly created st/files, it is recommended that you
check them for defects in an STL-repair application, such as Magics™, by
Materialise®.
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Choosing the Support Strength

When producing models, support material fills some hollow and empty sections
(see "Manual Positioning" on page 5-22). Objet Studio allows you to adjust the
strength of the structure formed with the support material. This adjustment is
useful when producing either large/massive models or small/delicate models. For
most purposes, the default setting provides adequate support strength.

To change the strength of the support structure used when printing a
model:

1. Select a model on the tray.

2. Onthe Model Settings ribbon, in the Options group, click i
or—

7 On the Model Toolbar, click % .
or—

O From the right-click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.

Advanced Properties E

Grid Style [ ] Hollaw
(%) Standard

) Heawy
) Lite

Apply

Figure 5-55 Advanced Properties dialog box

Note: Ifan objectis splitinto shells, the Advanced Properties enabled vary with
the object selection. If a single element is selected only Hollow is enabled. If a
group of elements is selected only Grid Style is enabled.

3. Inthe Grid Style section, choose the support strength suitable for the selected
model. You can select a different support strength for each model on the tray.

O Standard—for models needing average support (most models).
O Heavy—for large models needing much support.

4. Click Apply.
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“Hollow”™— Filling Models with Support Material
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Many objects placed on the tray from st/ files are “solid.” This means that, when
printed, the model will be completely filled with model material. Often, especially
with large objects, this is unnecessary. Instead, the model can be filled with
support material, which is less costly. It is also advisable to fill models with
support material when preparing them for investment casting, since this material
burns off more quickly during the process of making the cast.

Objet Studio enables you to print objects on the tray with an outer shell of model
material and a center filled with support material. When using this feature, called
“Hollow,” the thickness of the shell should be no less than 0.5 millimeters.

To use the Hollow feature:

1. Select a model on the tray.
or—

[ On the Model Toolbar click % .
or—

O From the right-click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.

2. Select Hollow.

Advanced Properties E|
Girid Style Hallaw
(%) Standard
(O Heawy Shell Thickness: 1.35
{3 Lite

Figure 5-56 Advanced Properties dialog box
3. Set the shell thickness, in millimeters.

4. Click Apply.

Note: Thereis no change in the display of objects in Objet Studio when
Hollow is selected.

To inspect, change or cancel the Hollow setting:

1. Selecta model on the tray.
2. Access the Advanced Properties dialog box, as above.

3. Ifyou change or cancel the Hollow setting, click Apply.
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Displaying the Cross Section of Objects
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The Section feature enables you to view the interior of an object by “slicing” it on
any axis. You can then manipulate the object to inspect the interior from different
angles. This may be important for deciding on the type of support necessary
when producing the model (see "Choosing the Support Strength" on page 5-47).
Displaying an object’s cross section only affects how the tray is displayed on the
screen; it does not change the object itself.

To display a cross section of the tray:

1. From the Tools menu, select Section.
The Section dialog box opens.

Section

Section |

¢ Enable Clipping

Figure 5-57 Section dialog box
2. Select Enable Clipping.

3. Use the slider controls for the X-, Y-, and Z-axes to cut the tray so that you
see the cross section you want.

Figure 5-58 Left: Whole view; Right: Cross section view after using the
Z-slider
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Saving the Screen Display as an Image File

You can save the image displayed in the active viewing screen as a graphicfile.

To save the screen display as an image:

1. Press Ctri+B.
or—

From the Objet Studio Commands menu O , select Save Bitmap.

The Save Bitmap dialog box opens.

Save Bitmap @@

Savein: |9 STL Files =] = EB-
[C2-0096 G0 To Lask Folder Visited
I)2-0148

*Applications - Tab Coating.bmp

*TrayS.bmp

File name: |Applications - Tab Coating
BV el 1 indows Bitmap [*.bmp) Cancel

[rata Type: |F|GB True Color  [24-bit] j

Compressior: | Mon-Compressed j

Figure 5-59 Save Bitmap dialog box
2. Atthe top of the dialog box, select the appropriate folder.
3. Atthe bottom of the dialog box, enter a file name.
4. Openthe Save as type drop-down list, and select the file format.
5. Click Save.

Saving Build Trays

You can save your work in different Objet Studio file formats, depending on how
you want to use them later.

OBJTF Files

objtffiles contain instructions to Objet Studio and to Eden260V printers for
displaying and producing the st/files used on the tray. When you save build trays
in Objet Studio, they are saved as objtffiles.

Saving in objtf format is useful, for example, if you have not finished preparing the
tray for printing, or if you want to make changes before printing it again in the
future. objtffiles are also useful when working from your company's network,
where the STL files are stored.
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Note: Because the objtffile references the st/ files used, they must remain in the
same file location as when the objtffile was saved.
To save the tray as an objtf file:

8

> Inthe Tray Settings tab, File group, click *** .
To open trays saved as objiffiles, see "Opening Objet Tray Files" on page 5-15.

OBJZF Files

To conveniently save all of the files as they are positioned on the build tray, for
storing the job, or for transferring it to another location, Objet Studio compresses
them into one objzffile. To later use the objzffile, the file must first be expanded in
Objet Studio and its component files saved.

Note: If you export an objzffile containing a st/ file originally saved as read-only,
you cannot open (import) this objzffile to the folder where the read-only st/file is
saved.

To create an objzf file:

1. From the Objet Studio Commands menu O , select Export Packed Job.
The Save As dialog box opens.

2. Select the folder, set the file name, and click Save.

Note: You can also export a print job as an objzffile from the Job Manager
screen—see "Additional Server Features" on page 5-76.

To open an objzf file:

> Double-click on the objtffile.
or—

1. From the Objet Studio Commands menu O , select Import Packed Job.
2. Inthe Open dialog box, display the appropriate folder and select the file.

3. Inthe Browse for Folder dialog box, display the folder in which you want Objet
Studio to expand the compressed file, and click OK.

The objtffile and associated st! files are expanded and placed in the selected
folder, and the tray is displayed in Objet Studio.
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Customizing Objet Studio

You can customize Objet Studio to suit your particular working needs and
preferences. Features that you can customize include:

O Creating a quick-access toolbar for frequently used commands.
O Changing the position of the Quick Access toolbar.

O Minimizing the ribbon.

O Changing the Objet Studio color theme.

O Configuring default settings for objects placed on the build tray.

Creating a Quick Access Toolbar

As you work with Objet Studio, you may use certain commands frequently. You
can create a quick-access toolbar to make your work easier.

To create a quick-access toolbar:

1. Above the ribbon tabs, click © .
The Customize Quick Access Toolbar menu opens.

e

Customize Quick Access Toolbar

Inserk
Placemnent
Estimate
BEiuild
Qpern,..

More Commands. ..

Show Below the Ribbon

Minimize the Ribbon

Figure 5-60 Customize Quick Access Toolbar menu

2. Selecta command you want to add to the toolbar.
An icon for the selected command is added to the toolbar.

. :

Tray Settings Job Mana

b ¥ S

Insert || Placement Yalidate [Estimate Build

Miode| Build Process

Figure 5-61 Quick Access toolbar
To add another command, repeat the above procedure.
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3. Tochoose from a wider range of commands:

O From the Customize Quick Access Toolbar menu (see Figure 5-60 on the
previous page), select More Commands.
or—

O Right-click on the Objet Studio Commands icon O , or elsewhere on the
ribbon, and select Customize Quick Access Toolbar.

Customize Quick, Access Toolbar, ..

Show Quick Access Toolbar Below the Ribbon
Minirnize the Ribbon

Figure 5-62 Right-click ribbon menu
The Options dialog box opens.

Options rz|
Customize Choose commands from:
*opular Commands w Job Manager
Commands:
<Separators

,{d’- Autornatic: placement
@ Buid
:'} Ingert Model
© tew R
% Open
£ Placement validation -
@ Save

] 5how Quick Access Toolbar below the Ribbon

Kepboard shortcuts:

Figure 5-63 Quick Access Toobar Options dialog box

4. Open the drop-down list and select either Popular Commands or
Commands not on the Ribbon.

5. Select a command and click Add.
6. Click OK.
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Hiding the Ribbon

Display Colors

DOC-32020 Rev. F

To make more room for displaying the build tray, you can hide the Objet Studio
ribbons.

To hide the ribbons:
1. Right-click anywhere on the ribbon or on the menu bar, or in the Objet Studio
Commands menu © .

2. Select Minimize the Ribbon.

The ribbons disappear, but you can temporarily display the ribbon icons by
clicking Tray Settings or Job Manager on the menu bar. When you next
click outside of the ribbon, it disappears again.

To return the permanent ribbon display:

> Repeat the steps above to cancel Minimize the Ribbon.

You can customize some of the colors used for displaying Objet Studio screens
and for displaying objects on the build tray.

To change the colors used in Objet Studio screens:

1. Fromthe Tools menu, select Options.

Options. lﬁ

Appearance |Gid | Manipulate | Display | Settings |

Select Indication

Mode Shaded -

Calar

[ Transparent

Window's Backaround Calor
) Color

@ Gradient

Default

[ ok ][ cance |

Figure 5-64 Display settings
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2. Inthe Appearance tab of the Options dialog box, you can configure the
display.
O The Mode selection determines how models appear on the build tray. The
default method for displaying models on the build tray is as solid
(“shaded”) objects. The other options are WireFrame and Points.

O If Shaded is selected, you can display the model on the tray as a see-
through object.

Figure 5-65 Transparent display
3 Double-click the color patches to customize colors.

O The Windows Background Color settings enable you to change the color
behind the build tray—with either a solid or a two-color gradient.

3 Toreturn to the default display settings, click Default.

Changing Color Themes

Objet Studio offers a choice of four background color themes—blue, black, silver

and aqua.
B Oy ——
Hof Y B owdd o [Shingiaaid :
et e il oty bl el E"" Pt e e | i

Figure 5-66 Background color themes

To change the color theme:

> From the Style menu, select one of the options.
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Keyboard Shortcuts

You can define shortcut keys for frequently used commands.

To define shortcut keys:

1. Above the ribbon tabs, click * .
The Customize Quick Access Toolbar menu opens.

=)

Inserk
Placement
Estimate
Build
Qpen...

Maore Commands. .

Minimize the Ribbon

Customize Quick Access Toolbar

Show Below the Ribbon

Figure 5-67 Customize Quick Access Toolbar menu

2. Select More Commands.
The Options dialog box opens (see Figure 5-63 on page 5-53).

3. Click Customize.

The Customize Keyboard dialog box appears.

Customize Keyboard

Categories:

Print Previevs
Amange Tray
Model Settings
Job Manager

Cormmands:

Build

Build Properties
Default Properties..
Exit

Export Packed Job... —
Import Packed Job...

Job Manager...

M achine Properties w

Buid [}

Current Keys:

Press new shortcut kew:

Set Accelerator for:

Default w @
Description:

Build

Resat Al

Harme

Aszzigned to:
[Unazsigned]

Cloze

Figure 5-68 Customize Keyboard dialog box
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4. Select command Categories to display all the commands in that category, for
example, all the Model Settings commands.

Current shortcut keys are displayed.

5. Enter the shortcut key in the Press new shortcut key field, and click Assign.

6. If you want to redefine all shortcut keys, click Reset All.

Setting User Preferences

You can change several Objet Studio settings that affect objects placed on the
build tray.

To change default settings:

> From the Objet Studio Commands menu O , select User Preferences.

User Preferences E|
Euilding Style Gid Style

(3 Matte (¥) standard
) Glossy ) Heavy

() Like

Application Settings
Support Materials

[JLack Srientation

SUPFO7F £
[ Hollow
Quality: |High Quality [ Cancel ] [ cve

Figure 5-69 Setting work preferences
* Building Style—see "Surface Finish" on page 5-19.
* Grid Style—see "Choosing the Support Strength" on page 5-47.
* Application Settings:
O Lock Orientation—see "Freezing Model Orientation" on page 5-32.

O Hollow—see "“Hollow”— Filling Models with Support Material" on page 5-
48.
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Professional Mode Features

Some advanced features of Objet Studio are only accessible in Professional
Mode.

To see the current Objet Studio setting:

> Open the Tools menu.

Tools =|Skyle - -_@I -

Grid

Snap ko Grid

Constrainks Setkings. ..

Section

Flane alignment 3

V' | Professional Mode

Language...

Options. ..

Define Colors, ..

Figure 5-70 Tools menu, showing Professional Mode selected
If Professional Mode is selected, advanced features are displayed.

To change the Professional Mode setting:

1. Fromthe Tools menu, select Professional Mode.
The following message is displayed, reminding you that the change will only
take effect the next time you open Objet Studio—even though the check mark
next to the Professional Mode option appears immediately.

1 'j The configuration changes vou hawve made will nok take effect until the next bme you run the application.
-

Figure 5-71 Configuration-change message

2. Close and re-open Objet Studio to use the Professional Mode features.
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Default Settings

You can control the default settings of several Objet Studio features from the
Advanced tab of the Options dialog box.

To display the Options dialog box
> From the Tools menu, select Options.
or—

In the Objet Studio Commands menu © , click Options.

Options EI

Appearance Grid I anipulate Dizplay
Settings Advanced Troubleshooting

[ swita Zoam
(riemt Ohjects ALtarmaticaly

[ 0K ][ Cancel ]

Figure 5-72 Options dialog box, Advanced tab

The Advanced tab is only accessible when Professional Mode is active (see
"Professional Mode Features" on the previous page).

Automatic Orientation
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By default, when Objet Studio places objects on the build tray, it orients them
optimally, for the shortest printing time. If necessary, you can choose to cancel
automatic orientation each time you place an object on the build tray (see
"Automatic Orientation" on page 5-20). In any case, when objects are on the
build tray, you can change their orientation manually (see "Manual Positioning"
on page 5-22.)

To change the default setting so that Automatic Orientation is disabled:

> Inthe Advanced section of the Options dialog box, clear the check box.
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Automatic Zoom

When Auto Zoom is selected in the Advanced section of the Options dialog box,
the display zooms in, to display the objects placed on the build tray. This allows
you to carefully inspect and manipulate the objects.

By default, this feature is not enabled. In any case, you can change the zoom
level, as necessary (see "Zoom Options" on page 5-40).

OpenGL Driver Configuration
The OpenGL driver displays 3D graphics on your screen. There is normally no
reason to adjust its settings. If you suspect a problem with the way Objet Studio

displays objects, you can use the OpenGL Driver Configuration tool to check and
configure the driver settings.

To access the OpenGL Driver Configuration dialog box:

1. Fromthe Tools menu, select Options.
or—

In the Objet Studio Commands menu © , Click Options.

2. Inthe Options dialog box, display the Troubleshooting tab.

Options E|

Appearance Grid Manipulate Dizplay
Settings Advanced Troubleshooting

l OpenGL Driver Configuration...

[ 0K H Cancel ]

Figure 5-73 Access to OpenGL Driver configuration

The Troubleshooting tab is only accessible when Professional Mode is active
(see "Professional Mode Features" on page 5-58).
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3.

Click OpenGL Driver Configuration.

The dialog box that opens displays details of the pixel format ID (index) for the
window and the memory.

OpenGL Driver Configuration

Wwindow Pivel Format | Memary Pisel Format | Advanced

() Pixel Format 1D

@ Chooze Format | Option 1 3z
Calor Bits 24
Depinfits |32
Alpha Bits i

[ 0k ][ Cancel ]

Figure 5-74 OpenGL Driver Configuration dialog box

If you want to display the values and change them, click [:I Alternately, you can
select Choose Format and change the values in this dialog box.

To perform a test of the driver configuration and enter the suggested
pixel format ID:

1.
2.

Select Choose Format.

Click Test.
Objet Studio returns the recommended pixel format ID.

Objet Studio 3

L.l
\ll) Choose Pixel Format: 5

Figure 5-75 Recommended pixel format ID

3. Click OK.
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In the OpenGL Driver Configuration dialog box (Figure 5-74), select Pixel
Format ID and enter this number.

Click Apply.

Display the other pixel format tab, and repeat this procedure.
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Getting Additional Objet Studio Assistance

Objet Studio Help provides on-screen instructions and information, as you work.

To view Objet Studio Help:

> On the standard toolbar, click ¥ and then click Objet Studio Help.

Tools = Style - @) =

Ohijet Studio Help )

Troubleshooting
Check for Updates

@ about...
Figure 5-76 Help options

You can also view information on the following subjects:

O Troubleshooting opens a list of error messages and their explanations.

O Check for Updates checks if you are using the latest Objet Studio version.

Objet Studio Version, Material Module and Licensed Features

You can view details of the Objet Studio version, the material module installed,
and the features available with your license.

To view details of your Objet Studio installation:

> On the standard toolbar, click “ and then click About....

Tools - Style - | @ -
Ohijet Studio Help

Troubleshooting

Check far Updates

@ About...

Figure 5-77 Displaying Objet Studio details
About Objet Studio tab

The About Objet Studio tab shows the Objet Studio version number and basic
information about your computer.
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e] |

About Objet Studio | Materials Module I Feature License|

(IBJET

Obijet Studio Ver. 5.2

Copyright ® 2013 Stratasys Lid.
All rights reserved.

For Applications Support: applications-nkjet @stratasys.com

Operating System:  Professional -Service Pack 1 (Build 7601)

Processor: Pentium Vs
Awvailable Physical Memory: 515 MB
System Resources: 4%

Figure 5-78 About Objet Studio tab

Materials Module tab

The Materials Module tab shows details of the material module installed.

© X

Materials Module | Feature License

Module version:  9.2.7.7
Module Date: 28.01.2013

Module Properties: Default

Figure 5-79 Materials Module tab

® Module version

If a Materials Module upgrade (patch) was installed, the new Materials
Module version is displayed. If no patches were installed, the Module version
is the same as the Objet Studio version.

o Module date

If a Materials Module upgrade (patch) was installed, the date of its creation is
displayed. If no patches were installed, the Module date is the date of the
Objet Studio version.
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* Module properties

If a Materials Module upgrade (patch) was installed, its description is
displayed. If no patches were installed, “Default” is displayed.

Feature License tab

DOC-32020 Rev. F

The Feature License tab shows the Objet Studio features available with your
license.

About Dbjet Studio | Materials Module | Feature License | Credentials

= E den 2600
= Modes
High Quality
High Speed
b aterials
Mixed tray

Figure 5-80 Feature License tab

Click ¥ to expand the details for each feature.

* Modes shows the printing modes available.
See "High Quality/Speed Setting" on page 5-43.

» Materials shows model materials available.
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Monitoring and Managing Print Jobs

In the Job Manager screen of Objet Studio, you monitor and manage jobs sent to
the printer. There are a few differences between Objet Studio on client
workstations and on the computer connected directly to the 3D printer—the
server workstation.

* Objet Studio installed on a client computer only displays the queue and status
for jobs sent to the 3D printer server from that computer, and it allows the user
to edit only these jobs.

Note: Ifthere are several PolyJet printers on the local network, client
computers can connect to any of them, but only one at a time.

* Objet Studio installed on the computer directly connected to a specific 3D
printer (server), displays the queue and status for all jobs sent to that 3D
printer by the server and by all client computers on the network. It also allows
editing and manipulation of all jobs, and enables re-sending previously-
printed jobs to the printer.

% If Objet Studio is not connected to a printer (or printer server), you can
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prepare tray files for any PolyJet printer. Later, these files can be used by
Objet Studio on the appropriate printer server.
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Job Manager Screen

The Job Manager screen on the client and server workstations looks identical.

The only difference is that options only relevant to the server workstation are
disabled for client installations.

Job ManagerRibbon~| ?- Teosvey N
Jobs Queue_> e -
Print Progress— — Available
@ | 8§ | resources
Print History—| e e m o e s~ Material |
consumption

Waste status

- Tray Preview

Figure 5-81 Job Manager screen
The Job Manager screen is divided into panels:
+ Jobs Queue
* Printing Progress
* History
* Available Resources
» Material Consumption
* Tray Preview
* Waste
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Jobs Queue

On the server, the Jobs Queue lists the last 15 jobs sent from client computers.
On client workstations, it lists jobs sent from that computer to the server.

Information for each of the queued jobs is displayed, including the job status.

Status Meaning

Waiting Printing of this job has not started.

Building Printing of this job is in progress.

Stopped Printing of this job was interrupted. Printing can later be
continued (Resume) or begun again (Restart).

Error Errors occurred during the printing of this job, and it was placed
in the Jobs Queue again.

Editing This job is now being edited in Objet Studio.

Spooling The job file is being spooled in the printer.

Preprocessing The 3D printer is readying itself for printing: the cover locks,

the print heads warm up and are put in starting position, the
UV lamps are turned on, and the build tray level is adjusted.

On Schedule The job is scheduled to be printed at a specified time.

In addition, the following information is displayed:

* Owner—the computer that sent the job
* Build Time—the estimated building time for the job

» Model Consumption—the amount of model material required to complete the
job, and the amount actually used till now

» Support Consumption—the amount of support material required to complete
the job, and the amount actually used till now

Printing Progress

The Time panel shows printing times and the number of slices sent to the printer.

History

The History panel shows information for the last 50 jobs and their final status.
You can drag a job from History to Jobs Queue to print the tray again.

Available Resources

The Available Resources panel contains graphic indicators that show the amount
of available printing materials remaining in the printer.1

10bjet Studio displays the weight of the printing materials in both cartridges as long as each cartridge contains more than 100 grams of

material. The weight under 100 grams is not calculated and displayed. However, if a cartridge contains less than 100 grams of material,
the printer uses it—as long as the material in the other cartridge weighs more than 100 grams. In any case, the weight of each cartridge
is displayed in the printer application.

DOC-32020 Rev. F 5-67



Eden260V User Guide 5 Using Objet Studio

Material Consumption

* Actual—the amount of material used till now
* Required—the amount of material still needed to finish the job

Tray Preview

The Tray Preview panel displays the build tray view of the job selected in the Job
Queue or the History list.

On a server, you can open an enlarged preview window by clicking on the Tray
Preview display (see "Additional Server Features" on page 5-76).

Waste

The amount of waste appears when the cursor is over the Waste display.

Setting the Printer Connection

When your printer is installed, the server computer is connected to that printer.
Normally, there should be no reason to change this connection. Occasionally,
however, you may need to reset the connection, to connect the server to another
printer, or to use Objet Studio in offline mode (without a printer connection).

To set (or change) the printer connection:

>
1. Onthe Job Manager ribbon, in the 3D Printer group, click ==,

2. Inthe Set Printer dialog box, click Connect.

Set Printer Features E|
Printer
+- Desktop
+- Eden
+- Connes
+)- Objet260
+)- Objet350
) e Lok ]
Ok

Figure 5-82 Connecting to a printer (A)

DOC-32020 Rev. F 5-68



Eden260V User Guide 5 Using Objet Studio

3. Enter the computer name or its IP address, or click Browse to find and select
it.

Eriter printer name/|P address.

Browse...

Use 'Unknown' for off-ine mode.

Figure 5-83 Connecting to a printer (B)

4. Click OK.
When the connection is established, Objet Studio is configured to prepare
print jobs for that printer.

If you can see the material levels in the "Job Manager Screen" (see Figure 5-
81 on page 5-66), Objet Studio is connected to the printer.

Note: A printer can be listed by its name or by its computer's IP address.

Offline Mode

You can use Objet Studio to prepare trays for printing in offline mode, on a
remote computer or when the printer connection is not available. You also use
offline mode to prepare trays for printing with other printers. In this case, if Objet
Studio is currently connected to a printer, you must change to offline mode by
removing this connection.

DOC-32020 Rev. F 5-69



Eden260V User Guide 5 Using Objet Studio

To disconnect Objet Studio from the printer:

>
1. Onthe Job Manager ribbon, in the 3D Printer group, click ===

2. Inthe Set Printer Features dialog box, click Connect (see Figure 5-82 on

page 5-68).
Set Printer Features Ps__<|

Printer
Deskiop
Eden
Connex
Obijet260
Obijet350
Objst500

Figure 5-84 Disconnecting Objet Studio from a printer (A)

3. Inthe Printer Connection dialog box, delete the computer name/IP address.

Printer. Connection

Enter printer name/P address.

(Browse.. |

Use 'Unknown' for off-line mode.

Figure 5-85 Disconnecting Objet Studio from a printer (B)
4. Click OK.
“Unknown” appears in the printer-name field.

5. Click OK.
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6. Inthe pop-up message, confirm that you want to work in offline mode by
clicking No.

I Job Manager

1) Ohbijet Studio is in off-ine mode,

Do you wank Eo conneck o a 30 printer?

[ es §|[ Ma ]

Figure 5-86 offline message

When Objet Studio is in offline mode, you can configure it for preparing print jobs
for different printers.

To change the Objet Studio offline configuration:

1. Inthe Set Printer Features dialog box, select a printer type.

Set Printer, Features r5__<|
Frirter
Desktop
Eden
Connex
Obijet260
Obijet350
ooett Q = D
Ok

Figure 5-87 offline printer selection

2. Click OK (not “Connect”).
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Setting the Remote Printer Connection (Client Mode)

When you open Objet Studio for the first time in a client installation, you are
prompted to connect to a server computer that sends jobs to a 3D printer. To do
this, the server computer must be operating and connected to the local network.

To set (or change) the connection to the server-computer:

2

. On the Job Manager ribbon, in the 3D Printer group, click ===,

Enter the name of the server computer or its IP address, or click Browse to
find and select it.

Click OK.

Fo
e — | .
W, E— L= -
s N
Specify Server Computer name/|P address.
Use ‘Unknawn' for off-line mode.

Figure 5-88 Printer Server Connection dialog box

Job Manager Commands

The Job Manager ribbon has three icon groups:

3 3D Printer
3 Queue
3 Job

o 7 7 - ’ h! y
Connect Motifications | Top Up Down Botbom | Restart Stop Resume Delete View  Edit

30 Printer Queue Job

Figure 5-89 Job Manager ribbon commands

Icons are enabled or disabled according to their relevancy. For example, since
you cannot stop printing a job that is not being printed, the Stop command is
disabled when the printer is idle.

Job Manager icons are described in the table on the next page.
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The following operations are available on the Job Manager ribbon:

Group |lIcon Purpose
3D > Server: Sets the printer connection. See "Setting the Printer
Printer | connect Connection" on page 5-68.
Client: Sets the server connection. See "Setting the Remote Printer
Connection (Client Mode)" on the previous page.
=] Configures options for printer alerts. See "Configuring User Alerts" on
Notification page 5_75
Queue | 3 Server: Moves ajob to the head of the Jobs Queue.
T“’ Client: Disabled.
See "Jobs Queue" on page 5-67.
= Server: Moves ajob to a higher position in the Jobs Queue.
- Client: Disabled.
See "Jobs Queue" on page 5-67
7 Server: Moves a job to the bottom of the Jobs Queue.
Lo Client: Disabled.
See "Jobs Queue" on page 5-67.
B Server: Moves a job to alower position in the Jobs Queue.
| Client: Disabled.
See "Jobs Queue" on page 5-67.
Job 2 Server:
Rastart » Forajobinthe Jobs Queue—Prints it again (from the beginning).
» Forajobinthe History list—Moves it to the Jobs Queue for printing.
Client: Disabled.
See "Restarting Jobs" on page 5-78.
01 Server: Stops ajob in progress.
SR Client: Disabled
o9 Server: Continues printing the current job from the point where printing
e stopped.
Client: Disabled.
See "Resuming Jobs" on page 5-78.
. 4 Removes the selected job from the queue.
Dielete
x Refreshes the image of the selected job in the Tray Preview display.
S
2 Opens the Tray Settings screen and displays the tray. For deleted jobs,
-

this enables you to make changes before printing.
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In addition to using ribbon command icons, you can use commands on context

(pop-up) toolbars and from the Job menu on the standard toolbar.

Restart

Stop — r Delete
Edit _"""/2’.9 ¥ —— Resume

Export"// ™ Schedule

Figure 5-90 Icons on pop-up toolbar (server)

¥ T Delete
Edit—— &

Figure 5-91 Icons on pop-up toolbar (client workstation)

Note: Mosticons and menu commands are only enabled when a job is
selected.

%( When you position the cursor over an item, a tooltip displays the name of the
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command.

Job ~ Tools = Skwle -

I@ Skop...

*. Delete 1ob...

Show 3dProgress

& Export ...

Figure 5-92 Job menu options (server)
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Configuring User Alerts

Objet Studio can alert you (and others) to the status of jobs sent to the server for
printing. This is especially useful during long printing jobs, when the operator is
away from the printer. The following events can be reported:

* The level of model or support material is low.
* The job was interrupted.

* The job was completed successfully.
To send e-mail and SMS alerts, make sure that e-mail software supporting MAPI
is installed on the server computer. To send SMS alerts, the cellular phone
service must support the transmission of e-mail messages by SMS. Only the
subject line of the e-mail message is transmitted by SMS.

To configure Objet Studio to send notifications and alerts:

-3
1. Onthe Job Manager ribbon, in the 3D Printer group, click T .

Notifications g|
Sound Alert
@ (&) Voice Messages ) PC Speaker
7

Feport to Printer

HP Dreskl ot S30C/332C/335C [ Piner.. |
Report to s-mail
T Add Fecipient.

John Smith
Fremove Reecipient]

i
Add Recipient.

[¥] Repot via 5MS

A RenindMe |15 min | Before Cartiidges Emply

A RenindMe |100g v | Before Cartiidges Emply

Figure 5-93 Noitifications dialog box (server)

Notifications @

Sound Alert
@ () Voice Messages () PC Speaker
s
[] Repot ta printsr
poit ko e-mail
Add Recipient..
[J Repoit via SMS
0K Cancel

Figure 5-94 Notifications dialog box (client workstation)
2. Set the desired reporting options.
3. Click Details.
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x|

Select Events to report on;
Successful job finish
Job interuption

End of Material reminder

[ Ok ] [ Cancel ]

Figure 5-95 Event selection for alerts
4. Inthe Reports Events dialog box, select the alert events and click OK.

5. Inthe Notifications dialog box, click OK.

Printing from the Jobs Queue

If there is a job in the Jobs Queue, it is sent automatically to the Stratasys PolyJet
printer—as long as it is on, there is a connection to the printer, and the printer is
online.

Chapter 6 describes starting and operating the printer.

Additional Server Features

Objet Studio on the printer server includes the following additional features:
» Extended Tray Preview
* Editing Jobs
* Restarting Jobs
* Resuming Jobs
» Scheduling Jobs
» Exporting Jobs (objzf)
* Modifying the Job Manager Screen
These features are described below.

Extended Tray Preview

In this window, you can view the tray from different angles and magnifications
without leaving the Job Manager screen. In addition to displaying the selected job
in the Tray Preview pane, you can open an enlarged build tray window.

To display the build tray window:

1. Selectajob in the Jobs Queue or the History list.
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2. Clickthe Tray Preview pane.

YHYIGOEHOEND

s
Figure 5-96 Job Preview

O To change the tray magnification, turn the mouse wheel.

3 Toview the tray from a different perspective, click the relevant icon.

3O Toresize the window, drag its edge or corners.

If there are several objects on the build tray, you can exclude one or more from
being printed, without actually deleting the object from the tray file.

To prevent the printing of an object on the build tray:
1. Double-click on the object you do not want to print.
2. Display the Build tab.

3. Select Exclude from Build.

2-0148.5stl

|Info | Options | Build |

Exclude from Build

Objet Studio

' : Are you sure you want to exclude this model from build process?
L

Figure 5-97 Excluding a model from the build

4. Click Yes to confirm.

On server computers, you can use Tray Preview to dynamically display objects
as they are printed, layer by layer. This enables you to visually monitor printing
progress on the computer screen.

To display printing progress in the Tray Preview pane:

> From the Job menu, select Show 3dProgress.

%( This option uses additional system resources.
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Editing Jobs

You can open jobs in the Jobs Queue for editing.

To edit a job:
1. Selectthe job.

2. Click the Editicon &= .

The Tray Settings screen opens, displaying the build tray. The status of the
job in the Job Manager screen changes to “Editing.”

3. Editthe job.

LY
o

4. Onthe Tray Settings ribbon, click = .
The status of the job in the Job Manager screen changes back to “Waiting.”

Restarting Jobs

You can restart jobs from the Jobs Queue and the History list.

To restart a job:

1. Selectthe job.

"

2. Click the Restarticon “= .
The job status changes to “Waiting” (in the Jobs Quevue).

Resuming Jobs
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If the printing process is stopped or interrupted, you may be able to continue
printing the job from the point where printing stopped.

When resuming a print job, the printer tray does not move. The printer expects
Objet Studio to send the slice from where the stoppage or failure occurred.

To resume printing:
1. Selectthe job.

v
2. Click fesee
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Scheduling Jobs

You can schedule jobs to be printed at a future time. For example, you can
configure Objet Studio to start long printing jobs in the late evening and early
morning hours.

To schedule a job:

1. Selectajob in the Jobs Queue, and click & onthe pop-up toolbar.

2. Inthe Scheduler dialog box, set the Start Date and Start Time for the job.
Click on the Start Date arrow to open a calendar.

Iv Start Printing job in schedule:

Start Date: Sunday  11/04410 -
Bl apiizonn

Sun ton TueWwed Thu Fri Sat [-=

12 3|
4 5 B 7 8 3 10
W 12 13 14 15 15 17
12 19 20 21 22 23 XM
28 26 27 28 23 30 J

— Today: 4/11/2010

Figure 5-98 Scheduler with calendar displayed
3. Click OK.

Exporting Jobs (objzf)

You can save print jobs as compressed files.

%{ For an explanation of objzffiles, see "Saving Build Trays" on page 5-50.

To export a print job:

Select a job. :

On the pop-up toolbar, click =

In the Save Asdialog box, select a folder.
Click Save.

il e

Modifying the Job Manager Screen

DOC-32020 Rev. F

You can change the size of the sections of the Job Manager screen, by dragging
the panel edges. This applies to:

* the Jobs Queue panel
* the Time panel

* the History panel

Similarly, you can change the way the screen area is divided between the main
section (Jobs Queuel/ TimelHistory) and the panels on the right side of the screen.

You can collapse (hide) the right panels (Available Resources/Material
Consumption/ Tray View) by clicking the top of the panel.

> Click again to display the panel.
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Printer cover

Model matenal compartment

Filter compartment

Support material and waste
compartment

Figure 6-1 The Eden260V 3D Printer

Starting the Printer

Caution

« Do not attempt to operate the printer before being trained by an authorized
Stratasys representative.

« Observe all safety warnings and follow the safety guidelines described in
Chapter 2.

1. Turn on the main power switch, located at the back of the printer.

Figure 6-2 Main power switch and cable

The main power switch turns on the Eden260V printer, which includes the
built-in computer.
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2. After the printer-control computer boots, log in to Windows and launch the
printer-control program:

3 On the printer-computer desktop, double-click the Eden260V printer icon.
or—

3 From the Windows Start menu, select (All) Programs > Objet >
Eden260V.

%( A HASP plug containing a valid product activation key is required on the
printer computer. This is supplied during printer installation or upgrade. If the
application does not open and a HASP message appears, contact your
Stratasys dealer or service provider.

The printer interface screen opens. All monitoring and controlling of the printer is
done from this interface.

™ File " Options Help e RS
stratasys

05Jan 2010 16:06

Printer mode — Current activity

{

13

Previous job last slice: 1081

f

FullCure706  FullCure705 VeroBlack VeroBlack

e

Support materials Model materials

2080 gr

Display
toggle button

Online/offline button

Pause

Stop button button

Figure 6-3 Printer interface
%{ Eden260V installations use one monitor for displaying both the computer
running Objet Studio and the computer installed inside the printer. Make sure

that the KVM (keyboard-video-mouse) switch is in the correct position so that
the printer interface is displayed.
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Loading Model and Support Cartridges

Eden260V printers use two cartridges of Model material and two cartridges of
Support material, each weighing 3.6 kilograms when full. A graphical
representation of the cartridges loaded and their current weight appears in the
printer interface (see the figure on the previous page).

The printer uses RFID technology to automatically identify cartridges of
printing material. Tampering with the RFID module will render the printer
inoperable and may void Stratasys warranties and service contracts.

Important: If you need to replace the printing material currently installed with
another type, see "Changing the Printing Material" on page 6-12. Otherwise,
make sure to replace the material cartridge with one containing the same type of
material.

To load Model and Support material:

1. On the front of the printer (see the figure on page 6-3), push the door of the
relevant storage compartment to release and open it.

2. Ifyou are replacing a cartridge, grasp its handle and pull the cartridge out,
taking care not to twist or turniit.

3. Load Model and Support cartridges into their respective compartments.
(Note that the cartridges only fit into their correct compartments.)

You should feel some resistance, as a needle pierces the cartridge seal.

4. Checkthe printer interface to make sure that the new cartridge is detected
and that its weight is displayed (see the figure on the previous page).

5. Close the storage-compartment door.

Tips about loading and replacing material cartridges:

« You can replace material cartridges either before or during printing.

« You can load partially used cartridges, provided that they contain more than
100 grams of material.

« You can replace a partially used cartridge to avoid the need for replacing it
during printing.

« The cartridge type is automatically detected by the printer. If you replace a
cartridge containing different Model material, a message appears
recommending that you run the Material Replacement wizard to flush out the
old material.

« If printing stops for an extended time before you replace a material cartridge,
the printer may go into Standby or /dle mode. If this happens, see "Resuming
Production After Printing has Stopped" on page 6-10.
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Producing Models

The Eden260V printer produces models after they are arranged on a virtual build
tray in the Objet Studio application and sent to the printer from there. For
information about preparing model files for printing, see "Using Objet Studio” in
this user guide or Objet Studio Help.

Preparing the Printer

Before beginning to produce models, it is recommended that you check the
current printing quality of the print heads by performing the Pattern Test.

To prepare the printer for producing models:

1. Make sure that the build tray in the printer is empty and clean. If not, remove
cured material with the scraper, and clean the tray thoroughly with a cleaning
cloth soaked with 90% alcohol (IPA or ethanol).

Caution

Use protective gloves when cleaning the build tray, and be careful of the
sharp edges of the scraper blade.

2. Make sure that there is sufficient Model and Support material loaded, as
indicated on the printer interface (see the figure on page 6-4). You may want
to replace the cartridges of Model and Support material currently loaded in
the printer to avoid the need for replacing them during printing.

Note: When you click Printin GrabCAD Print, a warning message appears if
there is not enough of one or more material.

For loading material cartridges and replacing empty ones, see "Loading
Model and Support Cartridges" on the previous page.

For changing the type of material currently loaded, see "Changing the Printing
Material" on page 6-12.
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You can monitor printer status by switching the printer interface display. To do
this, click the display toggle button on the printer interface screen.

05Jan 2010  16:25

Block temp. behind Block temp. behind
Support heads A Suppo

Temperature of each
Support head sk

Block temp. in front of )
Support heads Support/Model material

irsiaeblock reservoir

Waste weig ht Heads Liquid
Chamber temp. Heads Vacuum 1wl \/acuum level

UV Lamps L Pre Heater

Temperature of
=8 material pre-heater

Left UV lamp -
_ EDEN 260V Display toggle
Right UV lamp button
Printer set to offline
mode (red)

Figure 6-4 Printer status

Starting Printing

To begin printing:

> On the printer interface, click the red button to switch the printer to online
mode.

The color of the button changes from red to green (see the figure on page 6-
4). If there is a job in the Job Manager queue, it is sent to the printer.

When switching the printer to online mode, a message is displayed if a
maintenance activity is required to ensure optimum printing quality. (See
"Routine Maintenance Schedule" on page 6-21.) Maintenance natifications
can be disabled/enabled from the Options menu.

In the printer interface, the printer mode changes from /dle to Pre-print, as the
printer’'s components prepare themselves for production:

* The print block is heated.

» The UV lamps are powered and they warm up.

When printing begins, Objet Studio sends seven slices to the printer-control
application. This is the standard buffer between Objet Studio and the printer. As
each slice is printed, as a layer of the models on the build tray, another slice is
sent to the printer.

Depending on the size of the model(s) to be produced, printing can take between
several hours to several days. As long as there is enough Model and Support
material in the supply cartridges, printing proceeds automatically until the job is
finished.
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%{ During printing, the server computer must remain on and it must
communicate with the Eden260V printer. Do not log-off Windows until
printing is finished.

The Eden260V printer uses one Model-material cartridge and one Support-
material cartridge to produce models. When four cartridges are loaded in the
printer, two of them are reserve, or standby, cartridges. By default, the printer
first uses the cartridges with the least material in them. The printer interface
indicates which are being used (see "Printer Interface Color Key" below).

Printer Interface Color Key

The background colors in the printer indicator fields tell you at a glance whether
or not the value or item is suitable or ready for printing.

» Green—suitable/ready for printing
For example, in Figure 6-4 on the previous page:
O Ambient—The ambient temperature of the printing chamber is within the

acceptable range.

O Heads Liquid—The level of Model and Support material in the print-block
reservoir is OK.

O Heads Vacuum—The vacuum level in the system is within the acceptable
range.

* Blue—not ready
For example, in Figure 6-4 on the previous page:

3 UVlamps—The UV lamps are not on.

O Heads (°C)—The heads have not reached the temperature required for
printing models (in printing mode).

O Pre-Heater—The Model and Support resins need to be heated before
being supplied to the print block. The temperature has not yet reached the
acceptable range.

» Red—not suitable for printing (or indicates a warning)
For example, in Figure 6-4 on the previous page:

O Waste—The weight of the waste container is 9000 grams, more than
allowed when beginning a print job. (See "Replacing the Waste
Container" on page 6-78.)

The color of the material cartridges displayed in the printer interface indicates
which cartridges are active for the current (or next) print job.

For example, in Figure 6-3 on page 6-4:

* Blue—active cartridge

» Gray—reserve cartridge
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Printing Indicators

The printer interface screen changes when you send a print job to the printer, if
the printer is online:

* The mode changes from Pre-print to Printing.

* The specific activity being performed is shown in the “current activity” field.
* Current job-printing information is displayed.

* The printing progress bar is displayed.

» The Stop and Pause buttons are enabled.

When the weight of a cartridge drops below 100 grams, the display of the
material level in the printer interface is red.

06 Jan 2010  16:36

FullCure705  FullCure705 VeroBlack VeroBlack

l — — =@ Progres

2100 gr 1960 gr

Figure 6-5 Printer interface during printing
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Resuming Production After Printing has Stopped

If the printing process is interrupted, Job Manager stops sending slices to the
printer. This can happen, for example, if the printing material runs out in the
middle of a print job, and you do not replace the empty cartridge immediately.
After the printer changes to Standby or Idle mode, you need to resume printing
from the Job Manager screen of Objet Studio.

After printing stops, the printer goes into Standby mode, when heating of the
print heads is reduced. About 10 hours later, the printer goes into /dle mode,
when heating of the print heads is stopped.

To continue printing the model:

1.

If the printer is in offline mode, switch it to online mode by clicking the red
button at the bottom of the printer interface (see the figure on page 6-4).

The button changes from red to green.

If you don’t know why printing has stopped, make sure that the connection
between the printer and the server computer is active.

e

3. Inthe Job Manager screen of Objet Studio, click the Resume icon Fesure,

Printer

5.

DOC-32020 Rev. F

In the Continue from Slice dialog box that appears, confirm the slice number,
after checking the printer interface.

StrataS\/S' 10 Jan 2008 17:36

Print Time 00:20:51 Slice 168 of 1013 (16.6%)

Height 4.87mm of 29.37mm Previous job last slice: 1 Las-t

Figure 6-6 Printer interface after interrupted printing

Continue from Slice: X

163

[k | Cancel |

Figure 6-7 Continue from Slice confirmation in Objet Studio (Job
Manager screen)

If, for any reason, the correct number does not appear in the dialog box, enter
the number and click OK.
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You cannot continue printing the model if:

» The number of the last slice printed does not appear in the printer interface,
even if the server computer displays the Continue from Slice confirmation
dialog box.

» There was arelatively long interruption in printing, even if the “last slice” and
“continue from slice” indicators are correct. This is because the part already
printed might slightly deform or shrink before printing continues, causing a
visible difference between it and the part of the model printed later. The
effects of a printing stoppage depend on the model size and structure, the
Model material used, ambient temperature and the length of the stoppage.

If you cannot continue printing:
6. Remove the partially printed model from the build tray.

7. Restart the job from the Job Manager screen (in Objet Studio).

%{ You can stop and later resume printing from either the printer interface or the

DOC-32020 Rev. F

Job Manager screen of Objet Studio. After clicking the Stop button on the
printer interface, you can resume printing only from the Job Manager screen.
However, after clicking the Pause button in the printer interface, you can only
resume printing from the printer interface.
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Changing the Printing Material

Before producing models using a different type of printing material than is
currently installed, run the Material Replacement wizard to flush the print block
and feed tubes.

%{ You should carefully plan printing models with different materials to avoid
unnecessary waste of the materials currently loaded. The amount of material
flushed depends on the flushing cycle chosen and if you are replacing one or
both Model cartridges.

Note: When performing manual material replacement, certain replacement
options are blocked to protect the system. In these cases, follow the
recommendations of the Material Replacement wizard for best replacement
options.

To replace the printing material with the wizard:

1. Start the Material Replacement wizard from the Options menu.

Go ko Tray Upper Position FS
Go ko Purge Position F&
Wipe F7?
G0 ko Head Inspection Fa

Execute Purge Sequence  F4

Pattern Test F3
| Heads Yoltages Calibration 3 ‘Wiper Cleaning

Buil: In Tests... Chrl+-alt+E Head Cleaning
j Maint Court Uy Calibration

=n enancg OUPLELS: LY Lamp Replacement

Collect Service Data Fz ]

| Head aAlignment
Heads Filling Calibration

Head Replacement

‘Weight Test 3
Load Cell Calibration
Support Resin Support Resin Shutdawn

Figure 6-8 Starting the Material Replacement wizard
2. Inthe opening screen, click Next.

3. Ifthe printer cover is not closed, a screen appears, prompting you to close the
cover. Confirm that it is closed and click Next.

DOC-32020 Rev. F 6-12



Eden260V User Guide 6 Operating and Maintaining the Printer

4. Inthe Compartment Selection screen, select the compartment(s) containing
the printing material you want to replace, and click Next.

Material Replacement Wizard

Compartment Selection

[ Right model-material compartment

[ Left model-material compartment

[] Right support-material compartment

[ Left suppart-material compartment

stratasys

Figure 6-9 Compartment selection

5. From the drop-down menu, choose the material you want to install, and click
Next.

Material Replacement Wizard

Material Selection

4 | Selectthe new material for the 'model' compantment(s):

stratasys

’ xgancell ’{Erevious” Mext g l

Figure 6-10 Material selection

When SUP707 Support material is loaded, certain Model materials are not
available.
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6. Inthe Flushing Options screen, choose the appropriate cycle for the Model
material you want to install.

Material Replacement Wizard

Flushing Options

Qcﬁ Choose the flushing cycle required:

(%) Economy

O High-performance

stratasys

[ xgancell [%Erevious” Mext g ]
Figure 6-11 Flushing options

O Economy. During this cycle, which takes about 20 minutes, the pump
purges the Model material from the print block, then flushes the system
with the new material.

Since traces of the previous material may be present in the first models
printed with the new material, this cycle is usually acceptable when
replacing a light-colored Model material with a darker material (such as
TangoBlack™ or VeroBlack™), or if the exact color of the printed models
is unimportant. In most cases, models will have the mechanical properties
of the new material (except when switching between rigid and flexible
materials).

O High-performance. During this cycle, which takes about 55 minutes, the
wizard cleans the feed tubes and print block more thoroughly, compared
to the Economy cycle, by flushing the system with more material.

This cycle ensures that models will have both color and mechanical
properties of the new material. This is important when replacing a dark-
colored material (such as VeroBlack or TangoBlack) with a lighter-
colored material, and when switching between rigid and flexible materials.
This cycle is also recommended when changing the type of Support
material.
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7. Click Next, and take note of the warning.

Material Replacement Wizard

Please note:

Bewond this point, selecting 'Cancel' will abort the Wizard
and disable printing.

Frinting will be enabled only after completion of this
wizard.

stratasys

’ anncell ’{Erevious] | Mext = |

Figure 6-12 Material replacement warning

%{ Once you start this procedure, you must complete it before you can produce
models with the printer. To perform the procedure at another time, click
Cancel. If you continue (by clicking Next) and you do not complete the
procedure, you must start the Material Replacement wizard again before
producing models.

8. When prompted by the wizard screen, remove the material cartridge(s) and
load the replacement cartridge for the required compartment(s). Confirm this
in the wizard screen and click Next.

Material Replacement Wizard

Remove Cartridge

Confirrn before continuing:

[ Cartridge remaved from right 'model’ compartment.

stratasys
’ x LCancel ] ’{Erevious]

Figure 6-13 Cartridge removal confirmation
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If the printer does not identify the replacement cartridge(s), the following

wizard screen appears.

Material Replacement Wizard

mmgﬂhm Required Cartridges Not Loaded
Replace and confirm:

[ Cartridge lnaded in right 'model’ compartment.

stratasys

Figure 6-14 Prompt to load new Model cartridges

After identifying the cartridge(s), the printer begins filling the print heads with

the new Model material.

Material Replacement Wizard

Material Replacement in Progress

This process will take approximately 20 minutes.

00:07

stratasys

LCancel §

Figure 6-15 Material replacement: filling heads with new material

. Inthe final wizard screen, click Done.
The printer-control application is automatically updated, and it restarts.

When it opens, the interface displays the new material(s). Objet Studio (on

the server computer) is also updated and displays the new material(s).

10.Inspect the area around the purge unit and clean it, if necessary.



Eden260V User Guide 6 Operating and Maintaining the Printer

Keeping the Printer in Idle Mode
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Between printing jobs, the printer can be left unused for up to one week. If the
printer will not be used for more than a week, use the Shutdown wizard to
automatically perform the procedures that must be done before turning off the
printer (see "Shutting Down the Printer" on the next page).

When the printer stops producing models, the printer software automatically
reduces the temperature of the print heads, as follows:

After printing stops Mode Change in heating of
print heads

first 15 minutes Standby 1 no change

next 10 hours Standby 2 heating reduced

(to room temp.)

after Standby 2 Idle heating stopped

Note: The printer mode is indicated in the upper left of the main printer interface
screen (see the figures on pages 6-4, and 6-9).

If, after printing a job, you know that the printer will not be used for 10 hours or
more, you can immediately turn off the heating of the print heads by putting the
printer into Idle mode.

To put the printer into Idle mode:

> From the File menu (in the printer interface) click Exit.

Note: The printer remains in Idle mode until you open the printer application
and begin printing again.

When the printer is in Idle mode, do not turn it off. It can remain in this mode—
with the cover closed—for up to a week. For longer periods, shut down the
printer by running the Shutdown wizard (see "Shutting Down the Printer"
below).
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Shutting Down the Printer

You only need to shut down the printer if it will not be used for 30 days or more.
Otherwise, the printer can remain on, in /dle mode. However, if there is a need to
turn off the printer sooner, use the Shutdown wizard to automatically perform the
necessary processes before turning off the printer

%{ The Shutdown process flushes printing materials from printer components.

To avoid flushing out valuable material, make sure to print models at least
once a week. Many printer operators use this opportunity to print customer
samples or test models.

To properly shut down, the printer needs to perform several processes. These
are controlled by the Shutdown wizard. Except for immediate servicing, do
not attempt to shut down the printer by simply closing the computer
interface (the printer-control application), and never disconnect power
to the printer before completing this wizard.

& Caution
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Turning off the printer for an extended period without first running the wizard
can cause serious damage to print heads and other expensive printer parts.

Depending on the length of time the printer will not be used, you can choose
between a short shutdown procedure, and a more thorough procedure.

* Up to 10 days: The wizard empties the print block of Model and Support
material, to prevent leaks. This takes about 10 minutes.

* More than 10 days: The wizard empties the print block, then flushes the
system with cleaning fluid. This takes up to 35 minutes, and you must be
present to load a cleaning-fluid cartridge when instructed.

To run the Shutdown wizard:

1. Start the Shutdown wizard from the Options menu.

Shutdown Wizard

Select Shutdown Mode

G'GG Shutdown:

(®) Up to 10 days.

() More than 10 days [requires cleaning-fluid cartidges).

Stratasys
Figure 6-16 Shutdown wizard, opening screen
2. Click Next.
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3. Select the option corresponding to the length of time that the printer will not

DOC-32020 Rev. F

be used—Iless or more than 10 days.

Note: Before selecting More than 10 days, make sure that cleaning-fluid

cartridges are available.

Shutdown Wizard

Select Shutdown Mode

\-.
[ G Q 1 Shutdown:
1 |
!
"'\. ._/"" (& Upto 10 days.

() More than 10 days [requires cleaning-fluid cartridges).

stratasys

Figure 6-17 Shutdown options

In the next screen, verify that the tray is empty and click Next.

Shutdown Wizard

Inspect the build tray

[ The build tray is inserted.

. N
R
| G | Confirm before continuing:
\ _./f
\N—-—-"’/

[ The build tray i clear [empty).

stratasys

’ X Cancel ] ’*(Erevious]

Figure 6-18 Tray status

The shutdown procedure begins.

Shutdown Wizard

...\

Shutdown in Progress

Oﬁ This step takes up to 10 minutes.

00:06

stratasys

Figure 6-19 Shutdown progress



Eden260V User Guide 6 Operating and Maintaining the Printer

5. When the final wizard screen appears, close the printer-control application
and shut down the printer computer.

Shutdown Wizard

N Shutdown Procedure Completed

Y'ou may now shut dawn the printer computer and turm off
power to the printer.

stratasys

Figure 6-20 Final Shutdown wizard screen

6. After the printer computer shuts down, turn off the main power switch at the
back of the printer (see Figure 6-2 on page 6-3).
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Maintaining the Printer

Performing routine maintenance tasks is essential for getting satisfactory results

from your printer. Perform the tasks at specified intervals.

Routine Maintenance Schedule

Frequency

Task

For More
Information

Before printing

Clean the UV lamp lenses.

See "Cleaning the
Print Heads and the
Roller" on page 6-
24,

Before / after printing

Check the UV lamp overheating indicator.

See "UV Lamp
Check " on page 6-
24,

Before / after printing

Clean the print heads and the roller surface.

See "Cleaning the
Print Heads and
the Roller" on
page 6-24.

Daily

Clean and inspect the wiper.

See "Cleaning and
Replacing the
Wiper" on page 6-
27.

Weekly

Perform the Pattern test.

See "Pattern Test"
on page 6-29.

Weekly—when printing with
Biocompatible materials

Calibrate the UV intensity.

See "Testing and
Calibrating the

UV Lamps" on
page 6-52.
Weekly Restart the printer computer and the
server computer.
Weekly Clean the roller waste collector. See "Cleaning the

Roller Waste
Collector and
Inspecting the
Roller Scraper"” on
page 6-31.

Every 300 hours of printing (A
reminder message appears.)

Calibrate the UV intensity.

See "Testing and
Calibrating the
UV Lamps" on
page 6-52.

Every 300 hours of printing

Optimize the print heads.

See " Calibrating
Print Heads" on
page 6-41.

Monthly, and after replacing print
heads

Check the alignment of the print heads.

See "Aligning the
Print Heads" on
page 6-37.
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Frequency Task For More
Information
Monthly Clean debris from the Z-axis shaft with a vacuum
cleaner.
Monthly Inspect the exhaust system (duct, fan,
connections).
Monthly Calibrate the load cells. See "Calibrating the
Load Cells" on
page 6-59.
Every two years orevery 3500 | Preventive maintenance visit by service engineer. | Contact your
hours of printing Stratasys service
provider.

Maintenance Counters
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The printer computer application records the dates and frequency for each
maintenance task. You can display the Maintenance Counters screen from the
Options menu.

Help

Jptions

o ko Tray Upper Position FS

20 Eo Purge Position F&

Wipe F7

Go to Head Inspection F&

Execute Purge Sequence F4

Pattern Test F3

Wizards »
Heads Yolkages Calibration »
Built In Tests, ., Ckrl+Alt+E

Maintenance Counkers, ..

2

Figure 6-21 Selecting Maintenance Counters

Callect Service Data

6-22
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If there is a maintenance task due, this is indicated on the main interface screen.

stratasys

Maintenance Required

Figure 6-22 Maintenance Required indicator

If this indicator appears, you can display the Maintenance Counters screen by
clicking on it.

il Maintenance Counters (Hours) f'ZI

File  Units

Item Total Dated Warning Time User Warning

Tatal Printing time: | ‘ | | | |

P is Due | | ‘ | | ‘

&

Operator Maintenance

LI Calibration

&

| || |
| || |

HEU | || |
|

Heads Cleaning

]

]

Pattem Test

&

E

Rollr Bath Inspeciion | | | | [ Reset

‘wiper Cleaning | | ‘ | |

Head Alignment | || ||

Load Cel Calibration | || ||
Restat Computer | || || Reset
Blade Replacement

‘Wiper Blade | | [ || \ Reset

Fiollr Blade [ || | [ (R ] O

i Save

Figure 6-23 Maintenance Counters screen

The Maintenance Required indicator appears by default for most operator-
performed maintenance tasks. The check box under “User Warning” controls
whether or not it appears when a particular task is due.

For maintenance tasks that are controlled by wizards, the dates and printing
times are reset automatically when the relevant wizard is run and completed
successfully. Manual maintenance tasks (for example, roller inspection and wiper
replacement) are reset by clicking the reset button in the Maintenance Counters
screen.

6-23
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UV Lamp Check

A heat-sensitive label is fixed to the UV lamp covers as a warning against
overheating. Its center changes from white to black if the temperature of the
cover reaches 65°C (150°F). If this occurs, do not use the printer, and call your
service provider. As a precaution, it is recommended that you check the label
before and after printing.

@— Normal
@— Overheating
problem

Figure 6-24 Heat-sensitive label on UV lamp cover

-
-

%{ If the UV lamp continues to overheat, and the temperature around the lamp

reaches 90°C (194°F), a heat fuse turns off the electricity to the power to the
UV lamp, the tray heater and the motors for the X, Y, and Z axes. In the
unlikely event that this occurs, the printer cannot be used until it is serviced by
an authorized service engineer.

Cleaning the Print Heads and the Roller
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Periodic inspection and cleaning of the orifice plates on the bottom of the print
block ensures that the print nozzles are not clogged. A wizard guides you through
the procedure, and adjusts components of the printer to enable you to perform it.
This procedure takes about 20 minutes, and should be done at the beginning of
the work day or before a big printing job.

To clean the print heads and the roller:

1. Prepare—
O 90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
O disposable cleaning gloves
O asupplied cleaning cloth or equivalent
3 amirror

2. Start the Head Cleaning wizard from the Options menu (see Figure 6-29 on
page 6-27).

6-24
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3. Follow the instructions on the wizard screens, and select the confirmation

check boxes.
o N . .
' L Head Cleaning Wizard

Flease check ifthe tray is inserted and empty, and
close the door.

[ Tray is inserted
[ Tray iz empty
[ Door s closed

stratasys

Figure 6-25 Tray and cover confirmation

4. Click Next.
The printer prepares for you to clean the print heads.

5. When the following screen appears, open the cover.

Head Cleaning Wizard

Are heads clean ?

Please open the door and clean heads.
[1Heads clean

stratasys

Figure 6-26 Head cleaning wizard—steps 5—11

«.@3 Warning: Hot Surface
The print head orifice plates (bottom surface) may be hot. Do not touch them
with your bare hands, and proceed with caution.

6. Place the mirror on the build tray.

7. Putonthe gloves.
Caution

Uncured printing material on the print heads might cause skin irritation. Use
disposable cleaning gloves to protect your hands.

8. Soak the cleaning cloth with alcohol.
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9. Clean the orifice plates, with a back-and-forth motion (see Figure 6-27). Use
the mirror to make sure that you have removed all of the residue material.

Figure 6-27 Cleaning the heads

10.Clean the entire roller surface, by rotating it as you clean.

Use this opportunity to clean the glass lens on the UV lamps using the
supplied sanding sponge.

11. When you have finished cleaning, select the confirmation check box in the
wizard screen (see Figure 6-26) and click Next.

12.Remove the cleaning materials from the printer and close the cover.

13.Select the confirmation check boxes in the wizard screen and click Next.

The head-purge cycle begins. When the process is complete, click Done in
the final wizard screen.

Head Cleaning Wizard
_—

Head cleaning completed

stratasys

Figure 6-28 Final wizard screen
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Cleaning and Replacing the Wiper
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A rubber wiper removes excess material from the print heads after the purge
sequence. This is done automatically before each print job, and performed
manually during maintenance tasks. You should clean the wiper and surrounding
area at least once a week. If the wiper is damaged or worn, replace it.

To inspect and clean the wiper:

1. Prepare—
O 90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
O disposable cleaning gloves

3 asupplied cleaning cloth or equivalent
O aspare wiper

2. Startthe Wiper Cleaning wizard from the Options menu.

ations Help

o ko Tray Upper Position  FS

strz o to Purge Position F&
Wipe F7
G0 to Head Inspection Fa

Execute Purge Sequence F4

Pattern Test F3

‘Wizards Makerial Replacement
Heads Woltages Calibration r Wiper Cleaning

Built In Tesks... Chrl+AE+E Head Cleaning

I Calibration

% Lamp Replacement
Head Alignment

Head Replacement
Weight Tesk 3
Load Cell Calibration
Head Filling Calibration
Support Resin Support Resin Shutdown

Maintenance Counters. ..
Collect Service Data Fz

Figure 6-29 Starting the Wiper Cleaning wizard

3. Inthe opening wizard screen, click Next.
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4. Make sure that the build tray is empty, and close the printer cover.
Confirm this in the wizard screen, and click Next.

Wiper Cleaning Wizard

Inspect the build tray

Confirm before continuing:

[ Tray iz inserted

'. nnnnnn .' [] The build tray is clear (empty). the cover is closed.

stratasys

Figure 6-30 Tray and cover confirmation

5. When the following screen appears, open the cover.

Wiper Cleaning Wizard

Inspect the wiper

Confirm before continuing:

[] The wiper blade iz clean.

(BEE888868)

stratasys

Figure 6-31 Wiper Cleaning wizard during steps 6—10

6. Puton the cleaning gloves.

7. Using a generous amount of alcohol on the cleaning cloth, remove any
material remaining on the wiper and the surrounding area.

8. Remove any pieces of waste material collected in the purge unit.

9. Inspect the wiper.

If the wiper is scratched, torn or worn, or if you cannot clean it completely,
replace it:

a. Graspitand pull it up and out of its bracket.

b. Insertthe new wiper blade, making sure that it is straight and secured well
on both sides.

10.1In the wizard screen (see Figure 6-31), confirm that the wiper blade is clean,
and click Next.

11.Remove all tools and cleaning materials from the printer, and close the cover.
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12.Confirm this in the wizard screen, and click Next.

Wiper Cleaning Wizard

Check if the tray is empty and close the machine
COvEr,

FEEEEEED) [ The tray is inserted

[ The build tray is clear [empty).
[ The cover iz closed.

stratasys

Figure 6-32 Tray and cover confirmation

13.In the final sceen, click Done to close the wizard.

Pattern Test

The pattern test is the basic verification of the printer’s ability to produce quality
models, since it demonstrates the condition of the nozzles in the print heads.
Make sure, therefore, that you perform this test weekly, and whenever you
suspect a printing problem.

To perform the pattern test:
1. Make sure that the build tray is empty.
2. Prepare a sheet of pink paper, A-4 or Letter size.

3. Inthe printer, tape the pink paper to the center of the build tray.

Figure 6-33 Paper positioned for pattern test

4. Press F3, or open the Options menu and select Pattern Test.
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File” Options Help

Go to Tray Upper Position F5
Go to Purge Position F&
Wipe F7
Go To Head Inspection F8
Go to Tray Lower Position F10
Execute Purge Sequence F4
Pattern Test F3

Dynamic Nozzle test

Wizards 4
Built In Tests... Ctrl+Alt+B
Maintenance Counters... Shift+Ctrl+C
Collect Service Data F2

Figure 6-34 Selecting Pattern Test
5. Click Yes in the Confirm dialog box to begin.

P 1

Confirm @

Perform Pattern Test?

.,
= (e
=

4

-
"

Figure 6-36 Sample Pattern Test

6. Carefully inspect the test paper to see if there are missing lines.
Too many missing lines, especially if they are in the same area, indicates that
the quality of printing when producing models will be poor. If this is the case,
see "Improving Print Quality" on the next page.

Note: Acceptable model quality is subjective, and depends on the type and
scale (size) of the models produced. As arule, however, more than 10
missing lines in one area of a column is considered unacceptable.
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Improving Print Quality

If you suspect that print quality is poor, perform the Pattern Test (see "Pattern
Test" on page 6-29). If the results are poor, use the following procedure to
improve print quality.

If the results of the last pattern test are poor:
1. From the Options menu, select Purge Sequence, or press F4.

2. Inthe confirmation dialog box, click Yes.

The print heads are purged of Model and Support material, and the wiper
removes excess material from them.

3. Repeat the purge sequence.
4. Perform the pattern test.

If the results of the pattern test are still poor:

1. Manually clean the print heads (see "Cleaning the Print Heads and the
Roller" on page 6-24).

2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:

1. Carefully clean the print heads again, making sure there is no residue left on
them.

2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:

> Optimize the print heads and replace faulty print heads, if necessary (see "
Calibrating Print Heads" on page 6-41).

Cleaning the Roller Waste Collector and Inspecting the Roller Scraper

The roller waste collector removes waste material scraped from the roller.
Suction removes this waste to the printer’s waste container.

This assembly should be cleaned weekly to prevent a blockage in the tubes
leading to the waste container, so that waste material does not overflow into the
printer.
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To clean the roller waste collector:

1. Prepare—
O M2.5and M2 Hex (Allen) keys
3 disposable cleaning gloves
3 90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
O cleaning cloth
3 cotton swabs (Q-tips or similar)
3 mirror
3 flashlight

2. From the Option menu, select Go to Head Inspection Position.
3. Putonthe gloves.

4. Remove the right UV-lamp assembly:
a. Disconnect the UV power cable and the fan power cable.

Fanpower
connector

U Power
connector

Screw

Figure 6-37 Disconnecting the right UV assembly

b. Remove the screw that secures the right UV lamp, and then pull and lift
up the UV lamp.
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5. Loosen the two screws securing the suction tube on the print block.

Suctiontube
SCTEWS

Figure 6-38 Lifting the suction tube
6. Lift the suction tube to secure it in a raised position.
7. Remove the two screws securing the covering of the roller waste collector

and remove it.

Be very careful to save the covering screws. These are special screws; if they
are lost, you need to order replacements.

Rollerwaste
- collector screws

Figure 6-39 Removing the roller waste collector screws

8. Remove the covering by pulling it out, and then lower it.
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9. Clean the roller waste collector and the scraper blade surface using cotton
swabs. Make sure to remove any remaining printing materials.

Figure 6-40 Cleaning the roller waste collector

% Before replacing the covering, you can check the effectiveness of the roller
scraper—see below.

To check the effectiveness of the roller scraper:

1. Puton the cleaning gloves.

2. Wet a cloth with isopropanol.

3. Use the cloth to wet the bottom of the roller.
4

. Turn the roller slowly with your hand. As the blade scrapes the roller, make
sure the isopropanol is spread evenly over the entire length of the blade.

5. Inspectthe roller. Ifitis not dry, replace the blade. (See "Replacing the Roller
Scraper” on the next page.)

6. Before returning the roller waste collector to the print block, make sure that
the pins are clean.

Rollerwaste
collector pins

Figure 6-41 Roller waste collector pins

To re-assemble the components:

1. Return the roller waste collector to the print block and screw on the covering
(see Figure 6-39 on the previous page).
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2. Loosen the screws securing the suction tube.

" !
O == Securing screws

Figure 6-42 Positioning the suction tube

3. Lower the suction tube so that the hole in the panel behind the tube is visible,
and tighten the screws to secure the tube.

4. Attach the right-UV-lamp assembly to the print block and reconnect the UV
power and fan cables.

Replacing the Roller Scraper

You should replace the roller scraper blade—
« after 1,000 hours of printing.
« if it does not effectively keep the roller clean.

You should periodically test the effectiveness of the roller scraper when you
clean the roller waste collector. See "Cleaning the Roller Waste Collector and
Inspecting the Roller Scraper" on page 6-31.

To replace the roller scraper:

1. Prepare—
3 anew roller scraper blade (KIT-37017-S)
3 aPhillips 1x75 mm screwdriver
O a2.5-mmanda2-mm hex (Allen) key

2. Remove the right UV lamp and the roller waste collector covering (see steps
4to 7 onpage 6-32).

3. Loosen the two screws securing the roller waste collector and pull it out.

Figure 6-43 Removing the roller waste collector
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4. Remove the screws that secure the roller scraper assembly.

Figure 6-44 Removing the roller scraper screws

5. Remove the scraper blade and discard it.

Figure 6-45 Removing the old roller scraper blade

6. Place the new scraper blade onto the pins in the holder, as shown.

oval hole
(in blade)

round hole
(inblade)

Figure 6-46 Inserting the new roller scraper blade
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7. Insert and tighten the roller scraper blade screws.

Important:

« Tighten the screws in the order shown in Figure 6-47.
« Use the new screws supplied in the replacement kit

Figure 6-47 Tightening the roller scraper screws

8. After tightening the screws, inspect the blade and make sure that it is straight.
If necessary, loosen the screws and tighten them again, evenly.

9. Return the roller waste collector assembly and the right UV lamp to the print
block. (See steps 5to 7 on page 6-32 in "Cleaning the Roller Waste Collector
and Inspecting the Roller Scraper".)

Aligning the Print Heads
You should check the alignment of the print heads—
* once a month
« after replacing one or more heads

* if model quality is not acceptable even after cleaning the orifice plate on the
bottom of the print block (see "Cleaning the Print Heads and the Roller" on
page 6-24).

This procedure takes about 20 minutes.

To check the alignment of the print heads:

1. Prepare—
O atransparency sheet, about half of the standard A-4 or Letter size

O any type of adhesive tape, to fasten the transparency sheet to the build
tray

2. Start the Head Alignment wizard from the Options menu.
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3. When instructed to do so, place the transparency on the build tray—next to
the left and rear edges of the tray, as shown in the following figure.

Figure 6-48 Positioning the transparency on the build tray
4. Make sure that the transparency sheet is lying flat, and tape it to the tray.
5. Close the printer cover.

6. Inthe wizard screen, select the check box to confirm that the transparency
sheet is secured to the build tray, and click Next.

When you click Next, the printer prints the head alignment test on the
transparency. When printing is finished, the following screen appears.

Head Alignment Wizard

Remove transparency from tray
ed M
[ Transparency removed
stratasys
< >

Figure 6-49 Head Alignment wizard—steps 7-9

7. Open the printer and remove the transparency.
The transparency sheet is printed with sets of vertical lines in seven columns,
each showing the results from a different print head.
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Figure 6-50 Sample head-alignment test

O The three columns on the right were printed by the heads used for
applying Model material when producing models. From right to left, the
columns represent heads M1, M2, M3, respectively. (There is no column
for head MO because its alignment is used as a reference for aligning all
other heads.)

3 The four columns of lines on the left were printed by the heads used for
applying Support material. The columns represent heads S3, S2, S1 and
SO0, respectively.

For each column of lines, use a magnifying glass or loupe to inspect pairs of
consecutive rows printed on the transparency to see where the vertical lines
align.

1234567
SN |
RYRRN
RERRAR
RARRN
RIRRAR
RARRN
RERRAR

Figure 6-51 Comparing rows of alignment lines

Note: It does not matter which pair of lines you inspect, since they were all
printed by the same head. Choose a pair of clearly printed lines for the
inspection. (Since some nozzles may not print clearly, you may have to
inspect several pairs of lines to properly view the alignment.)

Optimum head alignment is shown when the fourth lines in the upper and
lower rows are aligned, as in Figure 6-51. In the example shown, no change
to the head alignment is necessary. If other lines in the set are aligned, you
need to change the alignment of that head—in the next wizard screens.
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9. Inthe wizard screen shown in Figure 6-49, select the Transparency removed
check box, and click Next.

The first in a series of alignment screens appears.

Head Alignment Wizard

1234567 Head M1

X\ S~
LI
FITTT Choose the best printed line in the transparency

1 2 3 4 5 § 7
L c ¢ O ® © O O
[NIRRAN

stratasys
’ xgancell ’(Erevious] | Met |

Figure 6-52 Head alignment selection

10.In the head-alignment screen, select the number that indicates which lines
align in the upper and lower rows of a pair on the transparency (counting from
the left) for this print head.

Note: Because the alignment of the fourth lines is optimum, the number “4”
is selected, by default, in the wizard screen. This does not change the head
alignment. If you select other numbers, the wizard adjusts the head
alignment, accordingly.

11.Click Next to display the next head alignment screen, and again select the
number representing the most closely aligned vertical lines on the
transparency for that print head.
When you have finished aligning all of the heads, the following screen is
displayed.

Head Alignment Wizard

Updating System Parameters
Do youwant to update the system parameters?
@) Yes
O No
stratasys
’ xgancell ’{Erevious” Mext g l

Figure 6-53 Parameter update confirmation
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12.Continue as follows:

O To make the alignment changes in the printer, make sure that Yesis
selected, and click Next.

O Torecheck the alignment test results before making the alignment
changes in the printer, click Previous.

O If you do not want to make alignment changes in the printer at this time,
select No and click Next.

13.In the following screen, you can choose to either repeat the head alignment
procedure, or close the wizard.

Head Alignment Wizard

Do you want to repeat the test?

() %es - Print another transparency

(&) No - | want to end of ‘wizard

stratasys

’ anncell ’%Erevious” Mext = l
Figure 6-54 Repeat head alignment option

O If the most closely aligned vertical lines for a print head were at either
extreme—the first or seventh lines—, choose Yes to run the Head
Alignment wizard again, then click Next.

The additional transparency test will show if the heads are now properly
aligned, and—if not—the wizard will allow you to “fine tune” the
alignment.

O Ifthe vertical lines for the print heads were not aligned at either extreme,
choose No to close the wizard, then click Next.

Calibrating Print Heads

The condition of the print heads directly affects the quality of printed models. To
maintain optimum printing, you should test the print heads and calibrate them to
the best working configuration possible every 300 hours of printing. You should
also calibrate print heads—

» whenever you suspect that the condition of print heads is negatively affecting
the quality of printed models

« if there is a problem with one or more of the print heads

» after replacing a print head

To perform the calibration procedure, use the external Head Calibration Utility.
You can download this application and related documentation from the Stratasys
Support Center.
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Replacing Print Heads

The condition of the print heads directly affects the quality of printed models. You
may need to replace a print head if one or more of the following symptoms
occurs:

* There are noticeable grooves in the surface of printed models.
* Visual inspection of the head reveals that its surface is damaged—peeling or
bubbles in the nozzle area.

* The pattern test or the weight test reveals that more than four consecutive
nozzles—or a total of more than 12 nozzles—are not functioning.

* The Head Calibration Utility indicates that a head cannot be calibrated for
acceptable printing (see " Calibrating Print Heads" on the previous page).

* The printer interface displays a warning or malfunction message relating to a
print head—

O Head Heater temperature timeout
O Head Heater thermistor open
O Head Heater thermistor short

Replace print heads only after attempting all other means for improving print

quality (see "Improving Print Quality" on page 6-31) and after consulting with
an authorized service engineer.

A wizard guides you through the procedure of replacing a print head, and adjusts
printer components to enable you to perform it. Only replace a print head with the
aid of the wizard. The entire procedure takes 75—90 minutes, and consists of the
following phases:

A. ldentifying the head(s) needing replacement.
This is usually done during the head-calibration procedure. Otherwise,
evidence of physical damage to the head surface or a malfunction message
indicates which head needs replacing.

B. Preparing the print block for head replacement.
This is done automatically when you run the Head Replacement wizard.

Removing the defective print head.
Installing a new print head.
Performing head calibration.

mmo o

Performing head alignment.

To replace a print head:

1. Prepare—
3 replacement print head(s)
O 90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
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3 disposable cleaning gloves (supplied with the print head; or use any clean,
powder-free protective gloves)

O asupplied cleaning cloth or equivalent

3 a5 mm flat-head screwdriver or a 3 mm Hex (Allen®) key (depending on
the type of print block)

Note: Make sure that you have these items before performing the head-
replacement procedure.

2. Open the Head Replacement wizard from the Options menu.

G0 to Tray Upper Position FS

Stri Go to Purge Position Fé
Wipe F7
Go to Head Inspection Fa

Execute Purge Sequence F4

Pattern Test F3

ds Material Replacement

Heads vaoltages Calibration wiper Cleaning
Built In Tests... Chrl+Al+EB Head Cleaning

Ly Calibration

L Lamp Feplacement
Head alignment
Head Replacement
‘Wweight Test
Load Cell Calibration
Head Filling Calibration
Support Resin Support Resin Shutdawn

Maintenance Counters, ..
Collect Service Data Fz

-

Figure 6-55 Starting the Head Replacement wizard

3. Inthe opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.

4. Read the conditions, select | Agree and click Next.
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Preparing the Print Block

5. Select the print head(s) needing replacement, and click Next.

6. The following screen appears when the printer is ready for you to replace

DOC-32020 Rev. F

Head Replacement Wizard

stratasys

’ x Cancel ] |‘( Previous | §>

Figure 6-56 Head selection screen

The printer heats and empties the print block, and prepares the printer. (This

should take up to 30 minutes.)

Head Replacement Wizard

\ Preparing for Head Replacement

Qﬁ This step can take up to 30 min.

00:09

stratasys

; Carcel | <% T

Figure 6-57 Printer preparation progress screen

print heads.

Head Replacement Wizard

Print Head Replacement

The printer is ready for you to replace print heads.
Click 'Next' to continue.

stratasys

(K]

Figure 6-58 Printer ready for head replacement
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7. Puton the protective gloves and open the printer cover.

Note: The printer disconnects power to the heads for your safety.

Removing the Defective Head

8. On the print block, release the upper and lower screws that secure the print
head in the block. (If necessary, you may use a tool to loosen the screws.)

Figure 6-59 Releasing the locking screws

9. Press down on the upper and lower locking screws to release the print head.

’
| ™ Fl
o A
- .':'rl--o gl
N 4 J

: H U““{‘ﬂﬂ;]

Figure 6-60 Releasing the print head
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10.Loosen the screws on the door of the compartment protecting the print-head
driver cards (A), then pull and lift up the door (B).

Figure 6-61 Opening the print-head compartment

11.Pull the print-head driver card out of its socket so that the head is free (A), and
remove it from the bottom of the print block (B).

A Y
/".’ & r- ﬁ.:
fis i
e

Figure 6-62 Releasing the print-head driver card to remove the head
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12.Make sure that along with the head, you remove the two rubber O-ring seals.

Figure 6-63 O-ring seals on the print head

%{ Important:

If the seals are not removed with the head, they are probably stuck to the print
block housing. If so, remove them.

Figure 6-64 Making sure the O-rings are not stuck to the print block
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Installing the New Head

13.Inspect the replacement head, and make sure that the O-ring seals are in
place (see Figure 6-63 on the previous page).

14.Gently insert the replacement head into the vacant slot in the print block, and
push the print-head driver card into its socket.

Note: Make sure to insert the head with the driver card facing its socket, in
the rear of the print block.

"E'Jr

._[f t[[[ '

Figure 6-65 Inserting the print-head driver card into its socket

15.Push the head up until you hear it click into place, in both front and rear
holders.

WWeeq
b )

'

Figure 6-66 Clicking the head into place in the print block

16.Lower the door of the print head compartment, and tighten the screws to lock
itin place.

17.Tighten the upper and lower screws that secure the print head in the print
block (see Figure 6-59 on page 6-45).

Note: Hand-tighten only! Do not use tools to tighten these screws.
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18.In the Replace print heads screen, select the check box to confirm that you
have replaced the head(s), and click Next.

Head Replacement Wizard

Replace print heads

Feferto the instructions included in the head
replacement kit, or click 'Help'. Confirm:

[IHead M3 replaced.
53525150 M3 M2 H1H0

stratasys

[ ? Help ] [ Wiew Movie ] <% T

Figure 6-67 Replace print heads confirmation screen

19.With your fingers, make sure that the new head is level and even with the

other heads.
e a ;,_J
TEUT T YW
SUAARIA |
T AT
] l!""‘\_‘L
b

Figure 6-68 Checking the level of the new head

20.Confirm that the heads are level and even by selecting the check box in the
following wizard screen, and click Next.

Head Replacement Wizard
I o

Installation Check
Check that the print heads are level and ewven.
\l [JDone
nnngnnnn
stratasys
’ X Carcel ] ’{Erevious] =

Figure 6-69 Installation-check screen
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21.When the following wizard screen appears, remove all tools and objects from
the printer and confirm that you have done so.

Head Replacement Wizard

Inspect the build tray

Confirm befare continuing:

[ Tray iz inserted.

[ Tray iz clear and the cover is clozed.

stratasys

[ x LCancel ] [{Erevious]

Figure 6-70 Cleared-tray confirmation screen

When you click Next, the print block is heated and filled with printing material.
Ifinstallation problems are detected, the wizard alerts you and instructs you
how to continue (see "Installation Problems".)

22 If print-head installation is successful, the wizard instructs you to clean all of
the print heads. Confirm that the heads are clean, and click Next.

Head Replacement Wizard

Clean the print heads

Confirm befare continuing:

[ The print heads are clean.

stratasys

Figure 6-71 Clean heads confirmation screen
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23.Remove all objects from the printer and close the cover. Confirm that you
have done so, and click Next.

Head Replacement Wizard

Inspect the build tray

Confirm befare continuing:

[ Tray iz inserted.

[ Tray iz clear and the cover is clozed.

stratasys

[ x LCancel ] [{Erevious]

Figure 6-72 Cleared-tray confirmation screen

Before using the printer to produce models, you should calibrate the heads and
check their alignment.

Head Replacement Wizard

N Wizard Completed

M Click ‘Done to exitthis wizard, and then:

1. Run the Head Alignment Wizard.
—— 2. Perfarm Head Calibration.

stratasys

Figure 6-73 Final wizard screen after successfully replacing print heads

Installation Problems

If the printer detects that there is a problem after you install print heads, a
relevant warning screen appears.

> If the printer software does not detect the replaced head:
If this happens:

a. Open the print head compartment (see Figure 6-61 on page 6-46).

b. Re-insert the print-head driver card into its socket (see Figure 6-65 on
page 6-48).

DOC-32020 Rev. F 6-51



Eden260V User Guide 6 Operating and Maintaining the Printer

> Ifthe replacement head was not calibrated by Stratasys, remove the head
and replace it with another one.

Head Replacement Wizard B‘

: Inserted head does not contain
- factory data

Q The installed head does not contain valid data. Try
% replacing it with anather head. Ifthis does not
succeed, contact Customer Support.

[~ Alternate print head installed.

stratasys
? Help

Figure 6-74 Invalid-head warning
Contact your Stratasys service provider about the uncalibrated head.

Testing and Calibrating the UV Lamps

The level of UV radiation from the lamps used for curing models can change over
time. To ensure optimum curing of models during printing, a pop-up message
reminds you to test the lamps and calibrate the level of UV radiation after every
300 hours of printing. You do this by running the UV Calibration Wizard.

To measure the UV radiation, you need:

» Stratasys TOL-03005-S (UV sensor and cable)
or—

» a stand-alone UV radiation meter, approved for use with the printer
The wizard compares the measured radiation to the recommended radiation
level for each of the lamps, at each printing mode—High Speed / High Quality.

When calibrating the lamps, the wizard attempts to adjust the radiation level, if
necessary.

* If the reading is within the acceptable range, the wizard continues to the next
phase.
* If further adjustment is necessary, the current phase is repeated.

* Ifthe level of UV radiation is too low to be properly adjusted, the wizard
continues to the next phase, but the final wizard screen indicates that the
lamp’s radiation for the printing mode is unacceptable.

% Before testing and calibrating the UV lamps:

DOC-32020 Rev. F

« Make sure the glass lens on each of the UV lamps is clean. For easy access,
run the Head Cleaning Wizard, and use the special sanding sponge supplied
in the Start-Up Kit.

« Make sure that the glass over the UV radiation sensor is clean.
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To test and calibrate UV lamp radiation:

1. Startthe UV Calibration Wizard from the Options menu.

2. Inthe following screen, select Calibrate UV Intensity to adjust the lamp’s
radiation level to the acceptable range.

UV Testing/Calibration Wizard

Select Action

(&) Test UV intensity

() Calibrate UV intensity

() Calibrate UV sensor box [Support use anly)

stratasys

Figure 6-75 UV Test/Calibration selection

3. Inthe following screen, select the UV sensor and measuring device to be
used.

UV Testing/Calibration Wizard

Select Device

(&) UV zensor box

() U external radiation meter

stratasys

Figure 6-76 UV device selection

%{ UV Measuring Device

When you use the Stratasys UV sensor box (TOL-03005-S), you connect it to
the printer. The wizard automatically measures and calibrates the UV
radiation.

If you use a stand-alone UV radiation meter, you need to manually enter the
readings from the meter in the wizard screens.
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4. Make sure that the build tray is empty. Confirm this in the wizard screen and

click Next.
- Check Printer

Q Confirm before continuing:
= [] The build tray is empty.

stratasys

Figure 6-77 Printer preparation

> When using a Stratasys UV sensor box that you connect to the printer
(TOL-03005-S), continue with "UV Sensor Connected to Printer" on the next

page.
> When using a stand-alone UV radiation meter, continue with "External UV
Meter" on page 6-57.
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UV Sensor Connected to Printe

The following steps apply when using the Stratasys UV sensor box that you
connect to the printer. They do not apply when using a UV external radiation

r

measuring device.

1. To synchronize the wizard and the UV sensor, enter the CF number from the
label on the back of the UV sensor box.

UV Testing/Calibration Wizard

stratasys

Synchronize the wizard and the
UV sensor
Enter the CF number printed on the LY-senzor label.

Figure 6-78

Figure 6-79

2. Click Next.
The build tray
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UV sensor synchronization

q‘! Stratasys”
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UV SENSOR
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Label on the bottom of the UV sensor box

lowers.
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3. Open the printer and connect the UV sensor cable to the connector in the
printer.

Figure 6-80 UV sensor connector in the printer
4. Position the UV sensor as shown in the wizard screen.

5. Confirm the items listed in the wizard screen and click Next.

UV Testing/Calibration Wizard

Place Sensor

Canfirm before continuing:

[ The % sensor box is connected to the printer.

[ The % sensor box iz positioned on tray a3 shown,
[] The glass in the U sensor box is clean,

[ The senzor cable is secured to the tray.

[ The printer caver is clozed.

stratasys

Figure 6-81 Sensor positioning
Continue with "UV Measurement " on page 6-58.
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External UV Meter

The following steps apply when using a stand-alone UV meter. This section does
not apply when using the Stratasys UV sensor box connected to the printer.

1.

© N o o &

When the following screen appears, open the printer and place the UV
sensor (probe) at the rear edge of the tray, in the center.

UV Testing/Calibration Wizard

N v Check Printer
— \
Confirm before continuing:
[ The U sensor is in the center of the tray's far edge.
[] The senzor cable is routed to the front of the printer.
Stratasys

Figure 6-82 Sensor placement screen

Lead the cable out of the printer so that you can close the printer, and tape it
down to make sure that it does not interfere with the moving print block.

i
Figure 6-83 Correct UV-sensor placement

Close the printer, while checking that the sensor does not move out of
position.

Set the UV meter to measure mJ/cm2.

Set the range on the meter to 2,000.

Connect the cable from the sensor to the UV meter.

Turn on the UV meter, and wait until “0 0 0.0” appears on the display.

In the wizard screen, confirm that the sensor is positioned correctly, and click
Next.

Continue with "UV Measurement " on the next page.

DOC-32020 Rev. F
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UV Measurement
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The UV lamps power up and stabilize. (This takes several minutes.) Then, the
print block passes over the sensor and the wizard compares the measured
radiation to the recommended level for each UV lamp. During this process, which
takes 20—40 minutes, you need to monitor the progress as displayed in the
wizard screen.

UV TestingfCalibration Wizard

UV Intensity Measurement
g) &=
’ -—

Currently reading  Right UV lamp  in High Quality Mode

Lamp Initialization
[ ] (120 sec.)

LY measurement

[ J

COverall progress

( J

stratasys

Figure 6-84 UV measurement progress

When using a stand-alone radiation meter (not the Stratasys UV sensor box
connected to the printer): Reset the meter and enter the reading (measurement)
when you are prompted to do so.

X]

Enter Value

Enter UV measurement device reading

H Cancel ]

Figure 6-85 UV Measurement dialog box
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If the UV level measured is not acceptable, the wizard calibrates the UV lamp by
adjusting the current supplied to it, and then tests it again.

When all UV tests have finished, the results are displayed, showing the condition
of the lamps after calibration (see Figure 6-86 below).

UV Calibration Wizard

stratasys
3

Figure 6-86 Results and condition of UV lamps after calibration

UV Calibration Results

Left L% Lamp Right L Lamp

HO o (173/1000% [1-1] |« (110/100) % [1->1]

He o (173/1100% [151] | % (110/130)% [1->30]

(too weak)

After examining the UV calibration results:
1. Click Next.

2. Remove the UV sensor and close the printer cover. After confirming the items
listed in the wizard screen, click Next.
If the results are not acceptable for quality printing, this is indicated in the final
wizard screen.

UV Testing/Calibration Wizard

Wizard Completed

stratasys

Figure 6-87 Final UV Calibration Wizard screen

Calibrating the Load Cells

DOC-32020 Rev. F

Load cells are sensors that measure the weight of the material cartridges and the
waste container in the printer. It is important that you periodically check that the
weight measurements are accurate to prevent unnecessary waste of printing
materials or printer malfunctions.

To calibrate load cells:

1. Startthe Load Cell Calibration wizard from the Options menu.

2. Select one or more load cells that you want to calibrate, and click Next.
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Load Cell Calibration Wizard

Choose Calibration Mode

[ Calibrate Model weight
[ Calibrate Suppart weight
[ Calibrate ‘waste weight

o

stratasys

Figure 6-88 Load cell selection

3. Remove the cartridge, as instructed by the wizard, confirm this in the wizard
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4.

screen, and click Next.

Load Cell Calibration Wizard

Remove Right Model Cartridge
from its housing

[ Right Maodel Cartidge removed

stratasys

’ X Cancel ] [(Erevious]

Figure 6-89 Confirmation of cartridge removal

In the next wizard screen, observe the numbers and wait until the weight level

is relatively stable—two units above or below the average level shown.

Load Cell Calibration Wizard

X Model Weight Status
Y G \
Gﬁ ) _;"I AD
\_-J Current Level nos
[]weight is stable
stratasys

Figure 6-90 Weight stabilization

5. Select the check box, and click Next.
If you need to calibrate more than one load cell, the next calibration screen

appears. Repeat steps 4 and 5 until all of the load cells are calibrated.
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6. Click Done in the final wizard screen.

Load Cell Calibration Wizard

oY

X

Wizard Completed

stratasys

? Help | ¢ Lione |

Figure 6-91 Final wizard screen

Replacing the Odor Filter

If the printer exhaust is not connected to an external ventilation system, a built-in
activated-carbon filter removes odors from printing materials. This filter should be
replaced regularly (as necessary) to keep your working environment pleasant.
This is normally done during the preventive-maintenance service visit.

If the printer exhaust is connected to an external ventilation system, the odor

filter is not needed and should be removed from the printer.

Odor filter removal improves heat expulsion and system cooling.

Replacing the UV Lamps

The UV lamps used for curing models have a long, but limited, working life. You
can test and adjust their effective power with the UV Calibration wizard (see
"Testing and Calibrating the UV Lamps" on page 6-52). If you need to replace a
UV lamp bulb or UV reflector, follow these instructions:

To replace the UV lamp bulb or UV reflector:

1. Make sure the printer is in offline mode.

Figure 6-92 Offline mode indicator (red)

The online/offline button at the bottom of the printer interface should be red. If
not, click it to switch the printer to offline mode.

Warning

Before continuing, make sure that the safety interlock is not defeated, and that
the UV lamp is not hot.

2. Startthe UV Lamp Replacement wizard from the Options menu.

DOC-32020 Rev. F 6-61



Eden260V User Guide 6 Operating and Maintaining the Printer

3. Make sure that the build tray is empty, and confirm this in the wizard screen.
Then, close the printer, and click Next.

UV Lamp Replacement Wizard

UV Lamp Replacement Wizard

Flease wverify that the tray is empty

[ Tray iz empty

stratasys

Figure 6-93 Tray confirmation
The axes move to the “home” position.

4. Selectthe UV lamp(s) to be replaced and click Next.

UV Lamp Replacement Wizard

Select the UV lamp you wish to
replace:

(®) Right UY lamp
O Left U lamp
O Both U lamps

stratasys

Figure 6-94 UV lamp selection screen
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5. Disconnect the UV-lamp power connector and the UV heat fuse connector.

UV heat fuse
connector

Note: Do not disconnect the power connection to the cooling fans.

6. Loosen the screw securing the UV lamp cover (A), and pull the cover up (B),
then out (C).

Figure 6-96 Removingthe UV lamp cover
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7. Pullthe UV reflector out of the print block.

Figure 6-97 Removing the UV lamp reflector

8. Using a 2.5-mm hex key, remove the UV lamp clamp (2 screws).

Figure 6-98 Removing the UV lamp clamp
9. Remove the UV lamp bulb from the UV reflector.

Figure 6-99 Removingthe UV lamp bulb
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10.Before continuing, inspect the spring-loaded pins. If there are burn marks
around the pins or if the pins are loose—their springs are not functioning
properly—and do not support the bulb, continue with step 15, to replace the
UV reflector.

Otherwise, continue with step 8 to replace the UV bulb.

Figure 6-100 Spring-loaded pin

11.Using the polyurethane tube provided in the kit, push the new UV lamp bulb
into the UV reflector. Make sure that the tip on the bulb is facing the slot.

Figure 6-101 Pushing the new UV bulb into the UV reflector
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12.Twist the tube by 180° (a), and continue to insert the UV lamp bulb into the
UV reflector (b).

N

(
y 0

Figure 6-103 Pushing the UV lamp into place

14.Using a 2.5-mm hex key, secure the clamp to the UV reflector, and continue
with step 25.

Figure 6-104 Attaching the UV lamp clamp
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15.Inspect the new UV reflector, and make sure that a black strip is attached to
the inside of it. If not, install one—on the side of the reflector opposite (not
next to) the print block.

Note: Extrablack strips are included in the printer Start-Up Kit. If necessary,
you can remove the black strip from the old reflector and install it in the new
reflector (as long as the black paint has not faded).

16.Discard the old UV reflector and lamp.

%{ Dispose of the used UV lamp in accordance with environmental and safety
requirements.

Warning: Broken UV lamp hazard
UV lamps contain mercury. Deal with broken lamps with caution.

« Ventilate the room thoroughly.

« Use protective gloves when collecting mercury and lamp components.

« Remove spilled mercury with a method that prevents the generation of
mercury vapor, such as a syringe, packing tape or paper.

« Place the broken lamp, mercury and contaminated materials in an air-tight,
non-metallic container.

17.Insert the UV reflector unit into the housing, next to the print block.

UV lamp=————= 1 UViamp
assembly assembly

Black stripg‘ /—Black strip

Figure 6-105 Print block and UV lamp assembly, showing correct
placement of black strip
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18.Replace the UV lamp cover by inserting it into the slot on the bottom of the
housing, and tighten the securing screw on top.

Figure 6-106 Replacing the UV lamp cover

19.Reconnect the power and heat fuse connectors.

Figure 6-107 Connecting the UV lamp

20.In the wizard screen, confirm that you have replaced the UV lamp and that
the black strip is attached, then click Next.

UV Lamp Replacement Wizard

UV Lamp Replacement Wizard

[ U4 lamp replaced
[] Shadow bracket located corectly (zee help)

stratasys
< >

Figure 6-108 UV-installation confirmation
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The wizard operates the UV lamps and checks if their power is within the

acceptable range for each printing mode.

Note: The mode currently being checked appears in the lower-left corner of

the printer interface.

UY Lamp Replacement Wizard

Oﬁ Y lamps warming (Approx. 4 min)

00: 04

stratasys
LT |

XK Cancel | =Z

UV Lamp Replacement Wizard

&

Figure 6-109 Status during UV lamp check

21.When the final wizard screen appears, click Done.

After replacing a UV lamp, it is recommended that you calibrate its power.
The next screen allows you to continue to the UV Calibration wizard (see
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"Testing and Calibrating the UV Lamps" on page 6-52).

UV Lamp Replacement Wizard

UV Replacement Wizard
[ c'o: : \ Completed
stratasys

Figure 6-110 Final wizard screen
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Built-in Tests

The printer application contains a suite of tests for regularly checking the
hardware and software, and for troubleshooting. You can configure basic
communications and environment tests to run automatically, when the
Eden260V application opens. In addition, you can run a more comprehensive set
of tests before processing a print job, as a system check, to ensure optimum
printing results.

Because running the tests affects the operation of the printer, you can only open
the Built-in Tests interface when the system is not printing.

The test suite features:

* The organization of printing-related tasks in categories:
Communications

Data cards

Temperatures

Voltages

Encoder repeatability

Print-head heating

Print-head filling

aaaaaaan

* A clear display of test results and the source of any failures, enabling you to
determine if printing is possible or worthwhile.

* The ability to monitor test results for specific components.

* Troubleshooting tips.
Running these tests can help identify problems in the printer hardware and
software. A large number of hardware defects (or near-defects) warns you of
possible printing problems, either for current or future jobs.

%{ Stratasys recommends running the built-in tests in the following cases:
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« as aroutine test, once every two weeks
« as asystem check, before major (long) jobs
« as needed, for troubleshooting
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To open the Built-in Tests screen, do one of the following:

» From the Options menu, select Built-In Tests.
* Press CtrI+Alt+B.

Cptions Help
o ko Trav Upper Position F5
a0 ko Purge Position F&
Wipe F7

(a0 ko Head Inspection Fa

Execute Purge Sequence F4

Patkern Tesk F3

N

Wizards
Heads Yoltages Calibration
Built In Tests... Ckrl+alt+B

R —

Maintenance Counters, .
Callect Service Daka

\[

Figure 6-111 Selecting Built-In Tests from the Options menu
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The Built In Tests screen lists pre-configured tests, grouped by component
categories. In this screen, you select and run tests, and the results are displayed.

Built In Tests

Test Mame Group Statuz  Error Description

O 5ub-System Communications Carrunicat. .. ?

O FIFD Mon-ntermupt Test Data Card ?

O FIFO Intermupt Test [rata Card ?

O Encoder Steps Count Encoder ?

O svstem Info Errvironment ?

[ Black Filing Filling ?

O Interlack. General ?

[ Cabin Temperature General ?

O Head EEPROM: Head Cads 9

[ Head Voltages Head Cards ? Surnrnary
[ Head/Block Heaters Heaters ? <
[ &wes Limits Motars ? B
O Paramemeter S anity Check Parameters ?

O acuum Test W acuum ?

< >

Tests Selection —

Graup Selection Set

’ All l ’ Mone l ’Unknownl - Mohe - W - Mohe - v .

Figure 6-112 Built In Tests screen

Test List

Test Name
This column lists all of the tests, together with selection check boxes.
Click the check boxes to select the tests you want to run. To remove a selection,
click the check box again. To quickly select all of the tests in a component
category, use the Group drop-down list at the bottom of the screen.

Group
This column shows the component categories for each test.
This tells you which tests are run when selecting a category from the Group drop-
down list at the bottom of the screen.

Status

This column shows the results of each test after you run it:

v" Test successfully completed.
X Test failed. (Double-click on afailed test’s line to review the failure details.)

7 Unknown results. (The test has not been run yet.)
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Test Selection Area

In the Test Selection area, at the bottom of the screen, you can quickly select or
de-select tests by their characteristics:

All

Click to select all of the tests in the list.

None

Click to de-select all of the tests in the list.

Unknown

Click to select all test that have not been run yet (Status = ?).

Group

Use this menu to select tests by component category.

Selection Set

Use this menu to select a pre-configured set of tests to run at
specified times (computer startup, before printing, etc.).

Running Built-in Tests

To run the selected tests:

> Click L=

After you run a test, the Save and View command buttons are added to the
Built In Tests screen.
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Test Results

To save and view a report of all tests:

> Use the Save and View command buttons.

Command Buttons

/- Miew

T 2le
< |1 Al
H & |3

Summary

X

‘8 Help
L Close

if

Click the command buttons, on the right side of the screen to perform the
following operations:
Run

Click to run the selected tests.

Reset
Click to clear previously run tests. This returns the status of each test to Unknown
(?).

Save

Click to save a report that summarizes the tests run. The report is saved as an
HTML file. You can save any number of reports for the tests you run; the name of
the file saved is BITReport [date][time].htm. By default, these files are saved in
the printer installation folder, but you can save it in any other folder.

View

Click to display the latest test report that you saved. (You can view other test
reports by opening the relevant files in your Web browser. To do so, open
Windows Explorer, and double click the BITReportfile.)
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Close

Click to close the Built-in Tests screen.

Summary

On the right side of the screen, a symbol represents the combined results of all
the tests run, using the symbols from the Status column.

v All tests successfully completed.
X At least one test failed.

? Not all tests performed.
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Test Descriptions and Troubleshooting

The following table lists the name of each test in the Built-in Tests suite, together
with its description and a possible reason for its failure. If you need assistance,
contact your Stratasys service provider.

Test Name

Description

Possible Reason for Failure

FIFO Non-Interrupt/
FIFO Interrupt

» Tests the data queue in the
DATA PCl card.

» Tests the Windows interrupt.

+ If both FIFO tests fail:
Faulty DATA_PCI card.

+ If only the FIFO Interrupt test fails:
Faulty Windows interrupt.

System Info Compares the following parameter | Failure of RAM memory allocation in
values with the minimum the printer computer.
requirements.
* physical memory
 available memory
» free space on disk
* monitor resolution
Parameter Sanity Compares the values of all printer One or more of the printer parameters
Check parameters (in cfg files) to the is not within the required range.
required values. Details appear in the BIT report.
Sub-System Tests communication between « Disconnected communications

Communications

printer components.

cable.
+ Faulty cable.

Cabin Temperature

Tests the temperature level in the
build-tray area.

+ Faulty temperature sensor (OHDB).
+ Failure of exhaust fan.
* Clogged exhaust filter.

Head EEPROMSs Tests the read/write capabilities of | Faulty print-head driver card(s).
the print-head driver cards.
Head Voltages Checks the control of voltages Faulty print-head driver card(s).

supplied to the print heads.

Head/Block Heaters

Tests the heaters in the print heads
and in the print-block body.

Faulty heaters or thermistors.

Axes Limits Tests the hardware and software Faulty hardware sensors.
limits of all axes. Wrong Max Position parameter.
Block Filling Analyzes the thermistor readings Faulty thermistor.

when the block is full and wheniit is
empty.

Encoder Steps Count

Tests the encoder's reliability by
comparing readings from multiple
runs along the X-axis.

Misaligned or faulty encoder.

Vacuum Test

Tests the vacuum level in the print
block.

+ Faulty vacuum sensor.
» Vacuum leakage.
» Wrong parameters.
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Test Name

Description

Possible Reason for Failure

Interlock

Tests the interlock in the printer
cover.

 Failure of interlock mechanism.
+ Faulty latch.
* Disconnected cable.

Version Tests

Checks the compatibility between
the software and component
firmware versions.
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Replacing the Waste Container

Printer waste contains partially cured polymeric material, collected during normal
operation and maintenance of the printer. For safety and environmental reasons,
this material is kept in a special leak-proof, disposable container.

The container has a capacity of about eight kilograms of waste material—usually
enough for several months of printer use. The printer application displays a
warning message when there are 7.3 kilograms of material in the container, and
stops the printing when the net weight reaches 7.8 kilograms. Above 7.3
kilograms, the software does not allow you to start a printing job or activity until
you replace the waste container.

Y ou can monitor the weight of the waste container in the Printer Indicators
display in the printer interface.

To monitor the waste weight (and other indicators) in the printer:
> In the main printer interface screen, click the display toggle to view the printer
indicators.

M siratasys

Heads (" C)

T
{34 J 35 ) 35 [ o5 NGB o5 | 35 §f 34 J 34 BT
T T

aste (or) Heads Liquid Bm
——-—'_-__-_

Waste Amblent (0 p——

WE|th g U\ Lamps B Pre Heater “

Clastiesl Modoc Dalaustdode

Figure 6-113 Printer interface, showing waste weight (red background
indicates operator alert)

The waste container consists of a sealed bag inside a cardboard box. You
typically dispose of the entire waste container—including the box. Therefore, you
must assemble a new box and insert a new waste bag before you can install it in
the printer.

Replacement boxes, waste bags, and sealing caps are supplied in the printer
start-up kit and in the preventive-maintenance kit.
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To prepare a new waste container:

1. Assemble the cardboard box, making sure to punch out the perforated
sections.

2. Fold a new waste bag—so it fits in the box—and insert the bag’s screw-
connector into the hole in the top of the box.

Note: Do not close the box until you connect the waste drain tube from the
printer.

To replace the waste container:

1. Push the door of the lower printer compartment to open it.

Waste
container

Figure 6-114 Waste container under the printer

2. Carefully slide out the waste container to remove it from the printer.

Figure 6-115 Waste container removed from the printer

3. Place the new waste container next to the full container.
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4. Unscrew the cap securing the waste drain tube and connect it to the new
container.

5. Close the full container with the cap supplied with the new waste container.
Note: The sealing cap contains an inner stopper that prevents leakage when

the cap is tightened. Do not be concerned that air can still flow through the
opening on the top of the cap, since the inner stopper seals the waste

container.

Stopper Opening in top

Figure 6-116 Waste container sealing cap

6. Close the new waste container box.

7. Position new the waste container in the printer.
Note: Make sure that the waste drain tube is not crimped or twisted, and that
it is not pinched by the container.

8. Close the compartment door.

Dispose of the full waste container in accordance with environmental and
safety requirements.
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Cleaning the Exterior Panels

The painted exterior plastic panels of the printer has a durable finish, offering
excellent chemical resistance to common cleaning materials. Follow the
recommendations below when cleaning these areas of the printer.

Acceptable Cleaning Agents

» mild soap solution
» common household cleaners and window cleaners
» common commercial and industrial detergents, 5% solution in water

* alcohol (ethanol, isopropanol), 10% to 40% solution in water
Wipe the exterior of the printer, using a soft cloth moistened with the cleaning
solution.
Unacceptable Materials

* industrial solvents
* cleaning agents containing hydrocarbons, ketones, esters and lacquer
thinners

* spray disinfectants

« abrasives and agents which could wear away the panel finish

Cleaning the UV Screen

The transparent section of the cover is made of strong, acrylic material that
screens out harmful UV radiation. Use extreme care when cleaning it to prevent
the appearance of scratch marks.

& Caution
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Do not use abrasive cleaners or cleaning fluids containing ammonia, alcohol,
acetone, benzine, carbon or tetrachloride. These materials can cause
permanent damage to the surface.

To clean the UV screen:

1. Blow off surface dust.
Do not wipe the surface to remove dust; this might scratch the surface.

2. Prepare a 1-percent solution of mild dish-washing soap in water—about two
teaspoons (10 ml) in a liter of water.
Note: While soapy water is effective for cleaning, commercial products are also
available for cleaning acrylic surfaces (for example, Novus® and Brillianize®).
These products give the surface antistatic, smudge and scratch-resistant properties.

3. Soak a micro-fiber cloth in the solution.
Do not use paper towels, which can cause scratch marks.

4. Thoroughly wet the surface with the cloth. Do not wipe!
5. Rinse the cloth with clean water.

6. Absorb the solution from the acrylic surface with the cloth, without applying
pressure.
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7. If necessary, repeat to remove any remaining marks, or apply clean water to
rinse the surface.

8. Ifthe surface is still wet, you can dry it with a clean, micro-fiber cloth by gently
wiping in one direction.

If convenient, you can apply the cleaning solution and water to the acrylic
surfaces with a spray bottle instead of with the cloth.
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Removing Models After Printing

After printing models, you should allow them to cool as much as possible before
handling them. If additional models do not have to be produced on the printer, it is
best to let the printed models cool in the printer, with the cover closed, as long as
possible.

If the printer must be used to produce additional models as soon as
possible:

1. Let the printed models cool on the build tray for at least 10 minutes.

2. Very carefully, remove the models from the tray with a scraper or spatula
(supplied in the tool kit), taking care not to pry or bend the model.

& Warning:

Wear protective gloves when handling printed models before they are
washed.

3. Place the models on a flat surface, and cover them with a cardboard box or
paper hood.

This allows the models to cool slowly and evenly.

4. Letthe models cool for several hours.

Removing the Support Material

After printed models have cooled, the Support material must be removed. This
can be done by different methods, depending on the type of Support material, the
size of the model, how delicate it is, the amount and location of the Support
material, and other factors. The methods described in this section refer to
removing general-purpose Support materials from models, for most printing
applications. Use this information as a guide, and adapt the methods (or a
combination of them) for cleaning your models.

% For special printing applications, refer to documents on the Stratasys Support
Center or consult a Stratasys 3D printing expert.

There are two types of Support material available:

» SUP705 (FullCure705), a gel-like Support material.

» SUP707, a water-soluble support material, suitable for some printers.

Removing SUP705
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SUP705 (FullCure705) Support material can be removed from printed models
using the following methods, in this order:

1. by hand
2. water pressure (in a suitable cleaning unit)

3. 1% caustic soda solution (recommended for a smooth finish)

Removing Support by Hand

While wearing protective gloves, break away excess Support material on the
outside of the model. For delicate models, use a toothpick, pin or small brush
after dipping the model in water.

Removing Support with Water Pressure

For most models, the most efficient way to remove Support material is by using a
high-pressure water jet. One suitable system is the Objet WaterJet cleaning unit.
This device is marketed by Stratasys.

Figure 7-1 Objet WaterJet Cleaning Unit

To clean a model using this device, you manipulate it and the water using the
built-in, waterproof sleeves. A pump turns ordinary tap water into a high-
pressure jet. A wiper keeps the window clear.

QE{ Use caution when cleaning delicate models with high-pressure water
systems.
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Removing SUP705 with Caustic Soda

Soak models in a 1-percent solution of caustic soda (sodium hydroxide) to
remove Support material from difficult-to-reach areas and to give the model a
smooth, clean finish. The amount of time you soak the model in the solution
depends on how delicate it is and how much Support material needs to be
removed, but it is typically between half-an-hour and several hours. In any case,
you should remove as much Support material as possible before the caustic soda
treatment, and rinse the model thoroughly (with a water jet) afterwards.

& Warning

Caustic soda may cause chemical burns, scarring and blindness. Mixing it
with water generates heat that could ignite other materials. Never pour water
into caustic soda. When diluting the solution, always add caustic soda to
water. Take adequate safety precautions; always use nitrile gloves when
handling caustic soda and models soaked in it.

Removing SUP707

SUP707 (water-soluble support material) can be removed from printed models
using the following methods, in this order:

1. water-whirlpool treatment (in a suitable cleaning unit)

2. 1% caustic soda solution (recommended to remove traces of support
material)

3. 15% glycerol (recommended to strengthen the walls of the model)

Removing Support Material with a Whirlpool Cleaning Unit
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When printed models are placed in a whirlpool water bath, jets of water and air
cause the support material to come free of the model and dissolve. One suitable
cleaning system is the DT3 CleanStation.

Figure 7-2 DT3 CleanStation

When the cleaning cycle is complete, inspect the models. If additional treatment
is necessary, replace the water in the cleaning unit and repeat the cleaning cycle.
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Soaking models in Caustic Soda (Recommended)

Soak models in a 1-percent solution of caustic soda (sodium hydroxide) to
remove excess support material and to give the model a smooth, clean finish.
The amount of time you soak the model in the solution depends on how delicate it
is and how much support material needs to be removed, but it is typically
between three to eight hours. Rinse the model thoroughly after soaking.

& Warning

Caustic soda may cause chemical burns, scarring and blindness. Mixing it
with water generates heat that could ignite other materials. Never pour water
into a caustic soda solution. When diluting the solution, always add caustic
soda to water. Take adequate safety precautions; always use nitrile gloves
when handling caustic soda and models soaked in it.

Strengthening Models with Glycerol

After printing with SUP707 support material and using the methods described
above to remove it from printed models, it is recommended to strengthen the
walls of models by immersing them in a 15-percent glycerol solution for a few
minutes.

Note: After this treatment, do not rinse the model, and allow it to dry overnight.

Post-Printing Treatment

Post-printing treatment is recommended for models printed with several special-
purpose materials or for special applications. Recommendations for treating and
finishing models after printing are described in the Best Practices for the desired
printing material available on the Stratasys Support Center.

Photobleaching for Transparent Models

Models printed with clear materials, such as VeroClear (RGD810) have a slight
yellow tint when removed from the printer. This is especially true for models
printed with a glossy finish. The yellow tint fades naturally over time, but you can
greatly accelerate this process by using a suitable photobleaching treatment.
This involves exposing models to intense light immediately after printing.

% Photobleaching methods and instructions are described in the Best Practices
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for the relevant clear material. These are available on the Transparent
materials page on the Stratasys Support Center.

Refer to the Best Practices for:
« VeroClear RGD810
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https://support.stratasys.com/Knowledge
https://support.stratasys.com/materials/polyjet-materials/transparent
https://support.stratasys.com/materials/polyjet-materials/transparent
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Storing Models

Models are cured as they are printed, making them safe and stable for a long
time. However, proper storage conditions are necessary to prevent deforming.

» Keep printed models at room temperature and in a low-humidity environment.

* Do not expose models to direct sunlight and other heat sources.
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